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BABI
PENDAHULUAN

1.1. Latar Belakang

Dunia pertambangan bahan galian dalam melangkahkan kakinya menuju
eksplorasi/produksi dapat berjalan apabila semua tahapan yang diperlukan dapat
terlaksana dengan baik dan benar. Pengumpulan data sekunder dan primer dapat
dilakukan terlebih dahulu sebagai bahan acuan awal dalam investigasi dan eksplorasi.
Salah satu dari semua tahapan yang ada tersebut adalah Survey dan Pemetaan yang
harus dilakukan demi pemenuhan kebutuhan terhadap data yang diperlukan. Kondisi
Geografis Lokasi pengukuran dan pemetaan Topografi untuk daerah KP-2 berada
pada wilayah Kecamatan Lelief, Kabupaten Weda — Halmahera Tengah yang berada
pada koordinat 127° 55' 59.99952" BT dan 0° 33' 30.000096" LU, 127° 59' 31.19964"
BT dan 0° 36' 24.3999" LU.

Survei dan Pemetaan Topografi adalah suatu proses untuk mengetahui secara detail
bentuk dan kondisi permukaan dari suatu daerah dengan cara melakukan pengukuran.
Hasil pengukuran yang diperoleh akan menghasilkan data koordinat (x,y) dan elevasi
dimana pengukuran ini berawal dari penentuan Bench Mark (BM) dan Grid yang
menjadi bahan acuan awal pengukuran. Dengan kata lain titik-titik yang dihasilkan
dari pengukuran ini akan langsung digunakan sebagai titik BorHole yaitu titik-titik
pengeboran yang digunakan untuk titik testspeed (borhole) pada pekerjaan Geologi.

Kumpulan titik-titik yang ada pada grid akan memiliki data koordinat dan ketinggian
dari hasil pengukuran sehingga melalui pengolahan data yang akurat akan
menghasilkan bentuk kontur dengan elevasi yang akurat pula. Berangkat dari data
elevasi tersebut perhitungan terhadap jumlah cadangan (deposit) dari bahan galian
yang akan ditambang dapat diketahui dan juga seberapa besar nilai ekonomisnya.
Jumlah ketebalan permukaan dan bijih bahan galian (Ore Body) harus dapat
diperhitungkan dengan benar dan akurat sehingga dapat ditentukan nilai ekonomis
yang akan diperoleh dan memperkuat kesimpulan dalam mengambil keputusan

penambangan.



1.2, Identifikasi Masalah

Dengan menggunakan GPS Trimble R3 dibantu dengan GPS ST Juno (GPS
Handhelt sebagai Navigasi), dapat dengan mudah dan efisien menentukan titik-titik
borhole serta melakukan pemetaan topografi dengan menghasilkan ketelitian yang
maksimal setelah proses postprocessing sehingga akan mempercepat pengukuran

topografi.

1.3. Tujuan Penelitian

Penelitian ini mempunyai tujuan untuk mendapatkan peta topografi dengan
data elevasi menggunakan GPS Trimble R3. Sehingga data hasil pengukuran dapat
digunakan sebagai rencana titik-titik BorHole dan dipakai sebagai acuan untuk
perhitungan/volume cadangan deposit Nikel (Ni) yang ada pada wilayah tersebut.

1.4. Batasan Masalah
Batasan masalah pada penelitian ini dibatasi hanya pada kegiatan pemetaaan
topografi untuk menentukan titik-titik borhole menggunakan :
a. GPS Trimble R3
b. Untuk pengolah data (raw data) menggunakan software : Trimble Business
Center, Trimble Data Transfer, Autocad Land Dekstop
c. Data yang digunakan adalah peta digital Halmahera Tengah skala 1 : 100.000

1.5. Manfaat Penelitian

Manfaat dari penelitian ini adalah mengoptimalkan penggunaan GPS Trimble
R3 untuk pemetaan-pemetaan topografi yang menghasilkan titik-titik koordinat
dengan ketelitian yang tinggi.

1.6. Metodologi Penelitian
Dalam penyusunan laporan untuk penelitian ini dipakai metode-metode yang
saling melengkapi satu sama lain :
1.6.1 Studi Pustaka
Studi pustaka dilakukan dengan mencari bahan acuan berupa literatur dan
buku-buku yang berkaitan dengan pemetaan topografi.



1.6.2 Studi Lapangan

Studi Lapangan yang dilakukan yaitu kegiatan pengukuran pada tanggal
18 Juni 2008 sampai dengan 30 September 2008 dalam proyek pemetaan
Topografi didaerah KP-2 dengan total pengukuran seluas + 1761.5 Ha pada
wilayah Kecamatan Lelief, Kabupaten Weda — Halmahera Tengah.

1.6.2 Studi Laboratorium
Studi laboratorium dilakukan untuk mengolah data-data yang diperoleh,
dengan menggunakan komputer dan perangkat lunak sebagai pengolahan, dan

evaluasinya.



BABHI

DASAR TEORI

2.1, Pemetaan Topografi

Pemetaan topografi adalah suatu proses menyajikan informasi muka bumi
yang berupa fakta (dunia nyata), baik bentuk permukaan bumi maupun sumber daya
alamnya, berdasarkan skala peta, sistem proyeksi peta, serta simbol-simbol dari unsur
muka bumi yang disajikan. Keadaan permukaan bumi yang digambarkan meliputi
unsur-unsur alam (misalnya: sungai, gunung, lembah), dan unsur-unsur buatan
manusia (misalnya: bangunan, jalan, saluran irigasi, batas kepemilikan). Untuk dapat
menggambarkan keadaan permukaan bumi tersebut, diperlukan pengukuran-
pengukuran geodesi (surveying) pada dan di antara titik-titik di muka bumi.

Secara garis besar pemetaan dibagi dalam dua cara, yang pertama adalah pemetaan
secara terestris, dimana seluruh data yang digunakan diperoleh dari hasil pengukuran-
pengukuran langsung di lapangan. Dan yang kedua adalah pemetaan dengan cara
ekstra terestris,dimana pengambilan data tanpa harus bersentuhan langsung dengan
lokasi pengukuran dipermukaan bumi, antara lain dengan, fotogrametris, citra landsat,
ikonos dan lain sebagainya.

Dalam pemetaan topografi cara terestris, titik-titik di muka bumi dikelompokkan
menjadi dua kelompok besar, yaitu kelompok titik-titik Kerangka Dasar dan
kelompok titik-titik Detail. Titik-titik Kerangka Dasar adalah sgjumlah titik yang
dibuat dan dipasang di lapangan (dengan tanda pengenal patok kayu dan pilar beton)
yang merupakan Kerangka Dasar pemetaan dengan fungsi sebagai titik pengikat
pengukuran titik-titik Detail, serta pengontrol pengukuran titik-titik lainnya. Titik-titik
detail adalah titik-titik yang ada di lapangan antara lain merupakan titik-titik pojok
bangunan, titik-titik batas tanah, titik-titik sepanjang pinggiran jalan serta titik-titik
lain yang letak dan kerapatannya ditentukan untuk menggambarkan bentuk dari
permukaan tanah.



2.1.1. Kerangka dasar pemetaan topografi

Di dalam geodesi dikenal dua macam titik Kerangka Dasar, yaitu: titik-titik
Kerangka Dasar Horisontal (KDH) yang mempunyai koordinat bidang datar (X,Y)
dan titik-titik Kerangka Dasar Vertikal (KDV) yang mempunyai harga ketinggian (Z).
Dalam prakteknya, titik-titik KDH dan KDV tidak dibuat sendiri-sendiri tetapi
menjadi satu titik. Jadi titik Kerangka Dasar mempunyai koordinat dan ketinggian
XY,Z).

Untuk titik-titik Kerangka Dasar Horisontal (KDH) dapat diukur antara lain
dengan cara-cara: triangulasi, trilaterasi, triangulaterasi, dan polygon. Dan untuk
titik-titik Kerangka Dasar Vertikal (KDV) umumnya diukur dengan cara sifat datar
memanjang.

Dengan perkembangan teknologi alat ukur beserta alat lunaknya saat ini,
pengukuran Kerangka Dasar pemetaan dan pengukuran titik-titik Detail dapat
dilakukan sekaligus dengan satu alat GPS Trimble R3 untuk menentukan posissi titik-
titik Kerangka Dasar dan titik-titik Detail dalam sistem koordinat tiga dimensi

X.Y.,Z).

2.2. Definisi GPS Secara Umum

Seiring dengan perkembangan ilmu dan teknologi, bidang geodesi tercatat
sebagai bidang yang mengalami perkembangan teknologi paling pesat, terutama
berkaitan dengan teknologi satelit. Kini di dalam ruang lingkup ilmu geodesi kita
mengenal Geodesi Satelit, yaitu sub-bidang ilmu geodesi yang menggunakan bantuan
satelit (alam ataupun buatan manusia) untuk menyelesaikan problem-problem
geodesi. Pemanfaatan sistem-sistem pengamatan geodesi satelit pada saat ini sudah
sangat luas spektrumnya. Spektrum pemanfaatannya mencakup skala lokal sampai
global, dari masalah-masalah teoritis sampai aplikatif, dan juga mencakup darat, laut,
udara, dan luar angkasa. Bentuk teknologi geodesi satelit diantaranya NAVSTAR
GPS (Navigation Satellite Timing and Ranging Global Positioning System), Glonass,
Galileo, Interferometric Synthetic Aperture Radar (InSAR), Satelit Altimetri, Satelit
Gravimetri, SLR, LLR, VLBI, dan lain-lain.

NAVSTAR GPS adalah sistem satelit navigasi dan penentuan posisi yang
dimiliki dan dikelola oleh Amerika Serikat. Sistem ini didesain untuk memberikan
posisi dan kecepatan tiga-dimensi serta informasi mengenai waktu, secara kontinyu di

seluruh dunia tanpa bergantung waktu dan cuaca, bagi banyak orang secara simultan.



Saat ini GPS sudah banyak digunakan orang di seluruh dunia dalam berbagai
bidang aplikasi yang menuntut informasi tentang posisi, kecepatan, percepatan
ataupun waktu yang teliti. GPS dapat memberikan informasi posisi dengan ketelitian
bervariasi dari beberapa millimeter (orde nol) sampai dengan puluhan meter.
Teknologi GPS mulai dikembangkan sekitar tahun 70-an oleh pihak militer Amerika
Serikat melalui Departemen pertahanan USA yang digunakan untuk kepentingan
militer negaranya. Seiring dengan perkembangan system ini, GPS telah digunakan
secara luas di pelbagai bidang di luar kepentingan militer, dan dikembangkan tidak
hanya di negara Amerika Serikat saja, melainkan di seluruh dunia. Pada lingkup
penelitian, GPS dapat digunakan untuk studi Geodinamika, deformasi, studi
oseanografi, dan lain-lain. GPS mampu memberikan ketelitian posisi sampai dengan
ketelitian sentimeter bahkan milimeter. Untuk mencapai ketelitian yang tinggi dengan
menggunakan GPS digunakan metoda kinematik diferensial baik itu secara real time
(RTK) maupun kinematic post processing. Untuk beberapa kasus biasa digunakan
Differential GPS (DGPS).

2.2.1. Kemampuan GPS

Beberapa kemampuan GPS antara lain dapat memberikan informasi tentang
posisi, kecepatan, dan waktu secara cepat, akurat, murah, dimana saja di bumi ini
tanpa tergantung cuaca. Hal yang perlu dicatat bahwa GPS adalah satu-satunya sistem
kemampuan handal seperti itu. Ketelitian dari GPS dapat mencapai beberapa mm
untuk ketelitian posisinya, beberapa cm/s untuk ketelitian kecepatannya dan beberapa
nanodetik untuk ketelitian waktunya. Ketelitian posisi yang diperoleh akan tergantung
pada beberapa faktor yaitu metode penentuan posisi, geometri satelit, tingkat
ketelitian data, dan metode pengolahan datanya.

2.2.2. Segmen Penyusun Sistem GPS

Secara umum ada tiga segmen dalam sistem GPS yaitu segmen sistem kontrol,
segmen satelit, dan segmen pengguna. Satelit GPS dapat dianalogikan sébagai Stasiun
radio angkasa, yang diperlengkapi dengan antena-antena untuk mengirim dan
menerima sinyal —sinyal gelombang. Sinyal-sinyal ini selanjutnya diterima oleh
receiver GPS di/dekat permukaan bumi, dan digunakan untuk menentukan informasi



posisi; kecepatan, maupun waktu. Selain itu satelit GPS juga dilengkapi dengan
peralatan untuk mengontrol attitude satelit. Satelit-satelit GPS dapat dibagi atas
beberapa generasi yaitu ; blok I, blok II, blok ITA, blok IIR dan blok IIF. Hingga april
1999 ada 8 satelit blok II, 18 satelit blok I A dan 1 satelit blok II R yang
operasional.Secara umum segmen sistem kontrol berfungsi mengontrol dan memantau
operasional satelit dan memastikan bahwa satelit berfungsi sebagaimana mestinya.
Segmen pengguna terdiri dari para pengguna satelit GPS di manapun berada, Dalam
hal ini alat penerima sinyal GPS ( GPS receiver ) diperlukan untuk menerima dan
memproses sinyal -sinyal dari satelit GPS untuk digunakan dalam penentuan posisi,
kecepatan dan waktu. Komponen utama dari suatu receiver GPS secara umum adalah
antena dengan pre-amplifier, bagian RF dengan pengidentifikasi sinyal dan pemroses
sinyal, pemroses mikro untuk pengontrolan receiver, data sampling dan pemroses data
( solusi navigasi ), osilator presisi , catu daya, unit perintah dan tampilan, dan memori
serta perekam data.

Gambar 2.1. Segmen penyusun GPS (Abidin,.2000)
2.2.3. Prinsip penentuan posisi dengan GPS

Prinsip penentuan posisi dengan GPS yaitu menggunakan metode reseksi
jarak, dimana pengukuran jarak dilakukan secara simultan ke beberapa satelit yang
telah diketahui koordinatnya, Pada pengukuran GPS, setiap epoknya memiliki empat



parameter yang harus ditentukan : yaitu 3 parameter koordinat X,Y,Z atau L,B,h dan
satu parameter kesalahan waktu akibat ketidaksinkronan jam osilator di satelit dengan

jam di receiver GPS. Oleh karena diperlukan minimal pengukuran jarak ke empat

satelit.
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Gambar 2.2. Prinsip penentuan posisi dengan GPS (Abidin,.2000)

2.2.4. Tipe alat (Receiver ) GPS

Ada 3 macam tipe alat GPS, dengan masing-masing memberikan tingkat
ketelitian (posisi) yang berbeda-beda. Tipe alat GPS pertama adalah tipe Navigasi
(Handheld, Handy GPS). Tipe nagivasi harganya cukup murah, sekitar 1 - 4 juta
rupiah, namun ketelitian posisi yang diberikan saat ini baru dapat mencapai 3 sampai
6 meter. Tipe alat yang kedua adalah tipe geodetik single frekuensi (tipe pemetaan),
yang biasa digunakan dalam survey dan pemetaan yang membutuhkan ketelitian
posisi sekitar sentimeter sampai dengan beberapa desimeter. Tipe terakhir adalah tipe
Geodetik dual frekuensi yang dapat memberikan ketelitian posisi hingga mencapai
milimeter. Tipe ini biasa digunakan untuk aplikasi precise positioning seperti
pembangunan jaring titik kontrol, survey deformasi, dan geodinamika. Harga
receiver tipe geodetik cukup mahal, mencapai ratusan juta rupiah untuk 1 unitnya,



GPS ST Juno GPS Trimble GPS Leica
(Handhelt) R3 500

Gambar 2.3. Macam-macam GPS ( Aneka ilmu GPS dan Alat, Web.)
2.2.5. Sinyal dan Bias pada GPS

GPS memancarkan dua sinyal yaitu frekuensi L1 (1575.42 MHz) dan L2
(1227.60 MHz). Sinyal L1 dimodulasikan dengan dua sinyal pseudo-random yaitu
kode P (Protected) dan kode C/A (coarse/aquisition). Sinyal L2 hanya membawa kode
P. Setiap satelit mentransmisikan kode yang unik sehingga penerima (receiver GPS)
dapat mengidentifikasi sinyal dari setiap satelit. Pada saat fitur "Anti-Spoofing”
diaktifkan, maka kode P akan dienkripsi dan selanjutnya dikenal sebagai kode P(Y)
atau kode Y.

Ketika sinyal melalui lapisan atmosfer, maka sinyal tersebut akan terganggu oleh
konten dari atmosfer tersebut. Besarnya gangguan di sebut bias. Bias sinyal yang ada
utamanya terdiri dari 2 macam yaitu bias ionosfer dan bias troposfer. Bias ini harus
diperhitungkan (dimodelkan atau diestimasi atau melakukan teknik differencing untuk
metode diferensial dengan jarak baseline yang tidak terlalu panjang) untuk
mendapatkan solusi akhir koordinat dengan ketelitian yang baik. Apabila bias
diabaikan maka dapat memberikan kesalahan posisi sampai dengan orde meter.

2.2.6. Bias dan Error Pada Data Pengamatan GPS
Pada sistem GPS terdapat beberapa kesalahan komponen sistem yang akan

mempengaruhi ketelitian hasil posisi yang diperoleh. Kesalahan-kesalahan tersebut
contohnya kesalahan orbit satelit, kesalahan jam satelit, kesalahan jam receiver,



kesalahan pusat fase antena, dan multipath. Hal-hal lainnya juga ada yang mengiringi
kesalahan sistem seperti efek imaging, dan noise. Kesalahan ini dapat dieliminir
salah satunya dengan menggunakan teknik differencing data. Bias lonosfer juga akan
mempengaruhi kecepatan, arah dan polarisasi sinyal GPS yang melaluinya. Efek
ionosfer yang terbesar adalah pada kecepatan sinyal sehingga akan mempengaruhi
jarak ukuran. Ionosfer akan mempercepat fase dan memperlambat pseudorange dari
sinyal. Selanjutnya apabila melewati troposfer sinyal GPS akan mengalami refraksi
yang menyebabkan perubahan, kecepatan dan arah dari sinyal GPS tersebut. Efek
utama dari bias ini adalah terhadap kecepatan atau dengan kata lain terhadap hasil
ukuran jarak. (Abidin,2004)

lonosphere

Gambar 2.4. Bias dan Erorr pada pengamatan GPS, (Abidin 2004)
2.2.7. Metoda penentuan posisi dengan GPS

Metoda penentuan posisi dengan GPS pertama-tama terbagi dua, yaitu metoda
absolut, dan metoda diferensial. Masing-masing metoda kemudian dapat dilakukan
dengan cara real time dan atau post-processing. Apabila obyek yang ditentukan
posisinya diam maka metodenya disebut Statik. Sebaliknya apabila obyek yang
ditentukan posisinya bergerak, maka metodenya disebut kinematik. Selanjutnya lebih
detail lagi kita akan menemukan metoda-metoda seperti SPP, DGPS, RTK, Survei
GPS, Rapid statik, pseudo kinematik, dan stop and go, serta masih ada beberapa
metode lainnya.
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2.2.8. Ketelitian Posisi yang diperoleh dari Sistem GPS

Untuk aplikasi sipil, GPS memberikan nilai ketelitian posisi dalam spektrum
yaiig cukup luas, mulai dari meter sampai dengan milimeter. Sebelum mei 2000 (SA
on) ketelitian posisi GPS metode absolut dengan data psedorange mencapai 30 - 100
meter. Kemudian setelah SA off ketelitian membaik menjadi 3 - 6 meter. Sementara
itu Teknik DGPS memberikan ketelitian 1-2 meter, dan teknik RTK memberikan
ketelitian 1-5 sentimeter. Untuk posisi dengan ketelitian milimeter diberikan oleh
teknik survai GPS dengan peralatan GPS tipe geodetik dual frekuensi dan strategi
pengolahan data tertentu.

2.2.9. Aplikasi-aplikasi Teknologi GPS

GPS (Global Positioning System) adalah sistem satelit navigasi yang paling
populer dan paling banyak diaplikasikan di dunia pada saat ini, baik di darat, laut,
udara, maupun angkasa. Disamping aplikasi-aplikasi militer, bidang-bidang aplikasi
GPS yang cukup marak saat ini antara lain meliputi survai pemetaan, geodinamika,
geodesi, geologi, geofisik, transportasi dan navigasi, pemantauan deformasi,
pertanian, kehutanan, dan bahkan juga bidang olahraga dan rekreasi. Di Indonesia
sendiri penggunaan GPS sudah dimulai sejak beberapa tahun yang lalu dan terus
berkembang sampai saat ini baik dalam volume maupun jenis aplikasinya.

2.3, Definisi GPS Trimble R3

GPS trimble R3 adalah alat pengukuran yang bekerja pada sinyal Frequency
L1 GPS dengan postpracessed dalam survei pengambilan data dilapangan, teknologi
GPS. Menggabungkan sebuah L1 GPS dan antena, dengan sebuah Controller,
schingga mudah digunakan dilapangan dengan sistem kontrol subcentimeter tepat ke
titik yang diinginkan dalam mengumpulkan data topografi. Sistem dapat beroperasi
di malam hari atau cuaca apapun, dengan menggunakan dua tipe survey. (Trimble;
Web).Versi Trimble ini dapat digunakan untuk dua tipe survei yang berbeda Faststatic
survei dan Postprocessed Kinematic (PPK) survei. Kedua tipe survei tersebut
menggunakan teknik postprocessed GPS survei. Artinya nilai koordinat yang akurat
untuk sebuah point yang sedang diukur, tidak dapat dilihat pada saat pengukuran.
Untuk pemrosesan baseline dan koordinat yang akurat,semua data yang terkumpul
harus diproses terlebih dahulu dengan menggunakan Trimble Business Center.
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1. FastStatic Survei
Teknik FastStatic biasanya digunakan untuk pengukuran titik kontrol

(BM) atau pengukuran yang memerlukan ketelitia tinggi. Metode ini

memerlukan waktu pengamatan yang lebih lama pada setiap titik yang diukur,

tetapi akan menghasilkan hail yang lebih teliti.

2. Postprocessed Kinematic (PPK) Survei

Teknik PPK digunakan apabila jika hanya menginginkan jumlah titik
pengukuran dalam jumlah yang banyak, seperti topografi survei. Karena
waktu pengamatan dikurangi hingga hanya beberapa detik saja maka metode
ini akan menghasilkan koordinat yang kurang teliti disetiap titik yang diukur.

Salah satu bagian terpenting dalam perencanaan sebuah survei adalah
penentuan tipe survei yang akan digunakan. Dalam pemilihan teknik faststatic atau
postprocessed kinematic (PPK) survei, yang harus dipertimbangkan adalah tipe
aplikasi survei dan akurasi data yang diinginkan. Trimble Digital Fieldbook software
sudah dikonfigurasi untuk berbagai macam survei, dengan menggunakan Job Filg
untuk memanage project data. Sebelum memulai survei kita harus membuat job baru
atau memilih job file yang sudah ada, raw data GPS akan tersimpan di DAT file pada
data collector.

Ketika survei telah slesai, kita harus mendownload semua data yang ada
dengan menggunakan Trimble Digital Fieldbook software ke komputer.Untuk
mendapatkan koordinat dari poin yang diukur,data base dan rover yang diperoleh dari
lapangn harus diproses menggunakan Trimble Business Software.

Dalam GPS Trimble R3 terdapat survei style yang digunakan sebagai
parameter dalam pengoperasian GPS. Parameter-parameter dari survei style tersebut
adalah ;

e Survei tipe — FastStatic or Postprocessed kinematic (PPK)
¢ Logging Device — Controller or GPS receiver

e Logging Interval — data measurement rate — in seconds

¢ Elevations mask — mask angle for satelite measurements

e PDOP mask — mask value for PDOP warnings

e GPS antenna tipe — tipe of GPS antenna

e GPS antenna height — default antenna height measurement

12



BAB I
PELAKSANAAN PENELITIAN

3.1. Gambaran Umum Lokasi Penelitian
a. Kondisi Geografis

Lokasi penelitian pengukuran dan pemetaan Topografi untuk daerah KP-2
berada di Desa Lelief — Waibulen yang masuk ke dalam wilayah Kecamatan Weda
pada Kabupaten Halmahera Tengah — Provinsi Maluku Utara, yang berada pada
koordinat 127° 55' 59.99952" BT dan 0° 33' 30.000096" LU, 127° 59' 31.19964" BT
dan 0° 36' 24.3999" LU. Adapun rute perjalanan terscbut adalah sebagai berikut :
Ternate (Pelabuhan Kotabaru) menuju Sofifi dengan Speed Boat dalam waktu kira-
kira 45 menit Sofifi menuju SP1 (Satuan Pemukiman — Transmigrasi) dengan
menggunakan mobil yang memakan waktu kira-kira 6 jam perjalanan SP1 menuju
tempat penelitian di Mermer dengan menggunakan mobil dalam waktu perjalanan
kira-kira 1 jam. Kondisi jalan menuju lokasi belum memadai dengan baik dimana
masih banyak jalan tidak berlapis aspal, hanya jalan tanah dan bebatuan schingga
terdapat banyak kubangan lumpur yang dapat menghambat perjalanan juga dapat
terhenti apabila sungai Akejira meluap schingga tidak dapat dilalui oleh kendaraan
bermobil.

b. Kondisi Geologi Pulau Halmahera

Tektonik regional Pulau Halmahera terbagi atas dua mandala utama geologi
yaitu Mendala Geologi Halmahera Timur atan Lengan Timur dan Mendala Geologi
Halmahera Barat atau Lengan Barat. Kedua Mendala geologi tersebut memiliki
karakteristik yang sangat berbeda. Daersh inventarisasi terletak di semenanjung
ﬁmwlaMpulauHalmahuamempakanbagiandaﬁMmdalaHalmahemTimur,
sedangkansemenanjmgmarasemPulmMommiadalahmempakanbagiandaﬁ
fisiografi Mendala Halmahera Barat. Hubungan antara kedua mandala berupa jalur
tektonik dengan perlipatan dan pensesaran yang kuat berbatuan sedimen Neogen.
Batuan penyusun Mandala Timur relatif lebih tua dibandingkan Mendala Barat.
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Gambar 3.1. Geologi pulau Halmahera (PSDG)
¢. Iklim dan Curah Hujan

Wilayah Maluku Utara dipengaruhi oleh iklim laut tropis dan iklim musim.
Oleh karena itu iklimnya sangat dipengaruhi oleh lautan dan bervariasi antara tiap
bagian wilayah yaitu iklim Halmahera Utara, Halmahera Tengah, Halmahera Barat,

Halmahera Selatan dan Kepulauan Sula.
Daerah Iklim Halmahera Tengah dan Halmahera Barat; dimana dipengaruhi
musim Utara pada bulan Oktober — Maret, pancaroba pada bulan April. Musim
Selatan pada bulan April — September yang diselingi angin Timur dan pancaroba pada

bulan September.

d. Kependudukan dan Lokasi Pemukiman
Penduduk terdekat dengan lokasi Kuasa Pertambangan PT. Tekindo Energy
adalah penduduk transmigran yang terdiri dari 4 (empat) wilayah desa yang terdiri
dari SP-1, SP-2, SP-3, dan SP-4. Mayoritas penduduknya bekerja sebagai petani dan

14



hidup dari hasil alam sekitarnya. Terdapat juga desa lain di luar daerah transmigran
tersebut, seperti Lelief, Sawai, Kulo dan Luko Lamo.
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Gambar 3.2. Lokasi keseluruhan wilayah KP
(Sumber : PT. Tekindo )
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e. Wilayah Pengukuran Topografi
Wilayah KP2 pengukuran dan pemetaan topografi yang dilakukan

mempunyai luas + 1.761.5 Ha dengan data Koordinat sebagai berikut :

No. BUJUR LINTANG

TITIK TIMUR UTARA
1 127.9333 0.6034
2 127.9580 0.6034
3 127.9580 0.6068
4 127.9920 0.6068
5 127.9920 0.6038
6 127.9910 0.6038
7 127.9910 0.6021
8 127.9860 0.6021
9 127.9860 0.6004
10 127.9820 0.6004
11 127.9820 0.5994
12 127.9810 0.5994
13 127.9810 0.5983
14 127.9700 0.5983
15 127.9700 0.5917
16 127.9680 0.5917
17 127.9680 0.5894
18 127.9640 0.5894
19 127.9640 0.5813
20 127.9620 0.5813
21 127.9620 0.5634
22 127.9640 0.5634
23 127.9640 0.5583
24 127.9333 0.5583
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Gambar 3.3. Lokasi pengukuran Topografi KP2
( Sumber : PT. Tekindo)
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3.2 Tahapan Perencanaan dan Persiapan

Tahapan Perencanaan dan persiapan merupakan hal yang sangat penting dalam
penelitian ini, dimana hasil akhir yang diharapkan tergantung dari perencanaan dan
persiapan yang dilakukan. Adapun perencanaan dan persiapan yang dilakukan antara
lain adalah Studi literatur, inventarisasi data serta informasi-informasi yang

dibutuhkan, penyusunan jadwal penelitian dan pelaksanaan penelitian.

3.2.1 Materi Penelitian dan Alat Penelitian
Materi atau bahan penelitian yang digunakan pada penelitian ini adalah:
a. Peta Digital Halmahera skala 1:100.000 digunakan sebagai acuan awal penelitian.

[ — -

|
I
i
I
|
>
1

Gambar 3.4. Peta Digital Halmahera skala 1:100.000
(Sumber : Bakosurtanal)

b. Peralatan survei (Survey equipment) yang digunakan untuk pengukuran : Trimble
R3 (Tripot Trimble R3, GPS Trimble R3, Antena GPS A3, Roll Meteran, Stick
Dipool Antena GPS) dengan dibantu peralatan pendukung lainya yaitu : GPS
Trimble Juno (untuk navigasi), Radio Panggil (HT) HYT, Radio RIG Alinco, laptop,
kompas, Mobile Phone Satelite R190, aki kering, palu, pita, paku, jas hujan dIl.
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Antenna GPS A3

Tripot GPS

Dipool Antena

GPS Trimble R3

Gambar 3.5 .Alat GPS Trimble R3 dengan perlengkapanya
c. Dengan software pendukung :

Trimble Business Center, Trimble Data Transfer, Autocad Land Dekstop,

Microsoft Excel, Microsoft Word.

1. Trimble Data Transfer yaitu software yang digunakan untuk mentransfer
data lapangan dari GPS R3 ke komputer.

Pastikan bahwa muncul icon yang menandakan bahwa Trimble GPS R3

dengan komputer sudah terhubung. Pada saat Transfer, data dari GPS berupa

extension “T017, setelah ditransfer berubah menjadi extension “DAT”.

Device =l. & i
|GiS Datelogger on Windows CE S ICO| oevces. | ;.:j,nﬁu—.
= ' Comnected o GIS Dataloggeron |t Transfer files dari
Foceive Serd) Sielovie CE » GPS ke komputer
Files to Send
Fie Size Data Type Source |
aFle
Waypoint
Background
Configuration
oot o st Tipe file yang
Coordinate System Export File i ¢ .
s ingin ditransfer
I Retain File List for this Data Transfer Session. l
Setings.. | Hep | ciose |

Gambar 3.6. Tampilan pada saat transfer data dari GPS ke Komputer
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2. Trimble Business Center yaitu software yang digunakan untuk
pengolahan setelah data lapangan dalam bentuk “DAT” ditransfer ke
komputer, yang kemudian dapat diproses disoftware ini dalam bentuk
koordinat-koordinat,elevasi dengan ketelitian yang diinginkan, dibawah ini

contoh tampilan awal saat pertama membuka software tersebut.

o Tipublie Bop v (et

e B v e S S Seer bt ben Bele e
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Gambar 3.7. Tampilan awal saat membuka Software Trimble Business Center

3. Autodesk Land Desktop Perangkat lunak Autodesk Land Desktop adalah
perangkat lunak komputer untuk bidang Computer Aided Design (CAD)
yang paling banyak digunakan dalam pembuatan peta digital dalam survey
dan pemetaan yang memiliki keistimewaan dalam pembangunan database.
Dengan fungsi-fungsinya yang semakin komplek pengguna lebih mudah
untuk penelitian ini, Autodesk land Enabled Map digunakan sebagai media
penggambaran grafis serta editing data peta untuk mempermudah
pengolahan data pada land desktop.
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Tampilan awal Autodesk land Enabled Map 2004.

M FHe Edt Vew Iset Fome Took Draw Dimension Modfy Express Window Heb

Gambar 3.8. Tampilan awal Autocad Land Dekstop
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Press ESC or ENTER to exit, or right-click to display shortcut menu,
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Gambar 3.9. Jendela kerja Autocad Land Dekstop

21



4. Microsoft Excel XP Profesional adalah sebuah perangkat lunak
spreadsheet, dimana penggunaannya untuk membuat lembar kerja

(spreadsheet), memformat spreadsheet, mengentri data, menganalisis dan

memecahkan masalah tabel serta pengolahannya.

Tampilan awal Microsoft Excel XP profesional

Mucrosoift”

Excel

Microsoft Gifice %P BH

54185-640-0000025-17519

Copyright® Microsoft Corporation 1385-2001,

V|
All iights reservad. This program

[ ad by US and
international copyright laws as duam.::l-hb About.

Gambar 3.10. Tampilan awal Microsoft Excel

5. Microsoft Word XP dengan kemampuannya yang telah banyak dikenal

dalam era komputerisasi digunakan sebagai media olah kata dalam
penyusunan Laporan Penelitian.

Tampilan awal Microsoft Word XP Profesional

541685-640-0000025-17519

Copyright@ Microsoft 1983-2001.
All rights rexerved. This program is protected by US and
international copyright laws as described in Help About,

Gambar 3.11. Tampilan awal Microsoft Word
d. Serta dengan didukung perangkat keras untuk pengolahan data :

Prosesor P4 1.7Ghz, Memory 1024 Mgz PC 3200, VGA Card Ge Force FX
7300 256 Mb, Hardisk 160 Gb MonitorKeyboard + MousePrinter
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3.3 Tahapan Pelaksanaan Penelitian
Sebelum melakukan pengambilan data dilapangn menggunakan GPS Trimble R3

terlebih dahulu harus diperhatikan penyetingan awal dari parameter-parameter survei
style dan pembuatan file atau job baru, sebagai tempat data-data tersimpan serta
tempat file-file yang apabila pengambilan data pada hari itu tidak selesai, maka dapat
dilanjutkan dengan membuka job tersebut, apabila pada awal pengambilan data
pembuatan job baru terlewatkan akan mengakibatkan kerancuan nama file yang
tersimpan.
3.3.1. Konfigurasi Software Pengambilan Data

Penyetingan awal pada alat dengan menkonfigurasikan Trimble Survei Style,
yaitu parameter-parameter yang digunakan dalam pengoperasian GPS Trimble R3.
Parameter-pameter survei style yaitu:

« Survei type - FastStatic or Postprocessed Kinematic (PPK)

» Logging device - Controller or GPS receiver

» Logging interval - data measurement rate — in seconds

» Elevations mask - mask angle for satellite measurements

» PDOP mask - mask value for PDOP warnings

* GPS antenna type - type of GPS antenna

» GPS antenna height - default antenna height measurement

3.3.2. Membuat Survei Style Baru
Berikut adalah langkah-langkah untuk membuat survei style baru. Langka
dibawah dilakukan apabila survei style yang diinginkan belum ada.
1. Untuk masuk ke menu Configuration pada layer menu utama:
Tap Configuration icon.
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2. Select Survei styles dan list menu.

3. Select New.

Corroler...
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4. Beri nama pada survei style yang akan dibuat.
« Tap Keyboard icon untuk membuka keyboard. Icon dengan lingkaran warna
merah di pojok bawah kanan.
» Apabila telah selesai mengetik, tekan Enter.

sy
[Fesi sune

+*

qlwlelritiyluitio|p
ajsiajfiogjh]s|k]l e

*" !l(’bﬂm._,-

Exx Sethto 3

Catatan - Pada contoh ini Trimble telah membuat survey style baru untuk Faststatic

survey.

5. Save perubahan yang telah dilakukan untuk survei style yang baru:
Tekan Accept.

-
a7 II
Zr)

Fast stau
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6 Survei style baru akan muncul di survei style list.
» Tekan Esc untuk kembali ke menu utama.

l]; C j iy

Mo survey PDOPZE
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3.3.3. Mengedit FastStatic Survei Style
Berikut ini default parameters untuk FastStatic survei style. Langkah ini hanya

perlu apabila anda ingin mengganti parameter-parameter yang ada.
1. Untuk melihat dan mengedit survei style parameter:

« Pilih FastStatic dan survei style list.

» Tekan Edit

2. Untuk mengedit pilihan rover GPS:
« Pilih Rover options.
e Tekan Edit

o} Fast statye 2 i

Rover aptinns
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3. Default Rover parameter seperti dibawah:

« Survei type - FastStatic
» Logging device - Controller
» Logging interval - 15 seconds
« Elevations mask - 13 degrees
« PDOP mask - 6.0
 Masukkan defauit tinggi GPS antenna
« Pilih GPS antenna type

Tekan ke bawah untuk melihat detail antenna yang lainnya.

Roveroptions . < d€21 @
_—
O s T k] a
Sunvey type:

L. S e
¥as1suandiii B Eonuulu[]
[ Logong Mterval: Auto fir nare
Elewabon mamk. PDOP marsa.
130000~ |¢][60 »

Exx  Swechto Acent, A

4. Pilih metode pengukuran tinggi GPS antenna, dan simpan perubahan yang
dilakukan untuk rover option:
« Pilih Bottom of antenna mount jika menggunakan pengukuran tinggi GPS
antenna sebenarnya.
» Tekan Accept.

B-lrscoptnln o =€ 10:40 '
T oTY - B

Measured tos

Bortom of antenna mount B

Part number: Senal number:

R S C—
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5. Untuk mengedit pilihan Base station GPS.

» Pilih Base options.
e Tekan Edit.

unsuuc :.‘-le:.uQ
:¢TT )

Rover options

- O
FastStatic point

Store I

¥o survey PDOP:2.6

Esc  Symrhto e, Al

6. Default base station parameter seperti dibawah:

» Survey type - FastStatic

» Logging device - Controller or Receiver

» Logging interval - 15 seconds

« Elevations mask - 13 degrees

» Masukkan default tinggi GPS antenna

« Pilih GPS antenna type

Tekan ke bawah untuk melihat detail antenna yang lainnya.

aueoptxm .'-‘.'-(Eujé
OT1TY -}

Survey tvpe:
astStabc

rtervak Austn File names:

1508 |w
El=vaton masi:

-

1300'00°

Iv]

29



7. Pilihan metode pengukuran tinggi antenna, antara lain:
« Bottom of antenna riount : vertical height measurement to base of threads -
(Trimble A3,Zephyr, etc)
» Top of notch : slant height measurement to edge of ground plane - (Zephyr

Geodetic antenna)
o Antenna Phase Center : height measurement to electronic phase center of

antenna.

Tekan Accept.

Ba{fgm o!l_qgi_hna Mg D
Bontom of antenns Mmount

N0 survey POOP:24

o swuhw saom, Ab|

8. Mengedit pilihan untuk pengukuran sebuah FastStatic point.

« Pilih FastStatic point.
» Tekan Edit.
040 ¢4
STy »
Rover options
Base options

No survey POOP:2.6

Ex Swirthto e, Al

30



9. Mengedit default waktu pengukuran untuk FastStatic rover:
LI default waktu pengukuran:
« Waktu dengan 4 satellites = 30 minutes
« Waktu dengan 5 satellites = 25 minutes
« Waktu dengan 6 satellites = 20 minutes
FastStati pomt o 4f 10140 €]

E O TT
HMM
- L1 FastStatic imes
Tena for 4 SVs:

0
Tone for S Svs:
[a5m0s |0

Tone for 6+ Svs:
|20m0s »

Catatan - Jika kotak Auto Store¢ point dipilih, maka point akan disimpan secara
otomatis jika sudah selesai.
Untuk menyimpan:
» Tekan Accept.

31



3.3.4. Mengedit PPK Survei Style
Berikut ini default parameters untuk Postprocessed Kinematic (PPK) survey

style. Langkah ini hanya perlu apabila anda ingin mengganti parameter-parameter

yang ada.
1. Untuk melihat dan mengedit survey style parameter:
« Pilih PPK dan survei styles list.

o Tekan Edit.
IM =

Size | Modified
tuasm 2xb 612412005
PP Ad 242005

4] a | »
%o survey PDOP26

New | Copy | Dckte |
Esc Spchto Ef.l:r,!Al‘:

2 Untuk mengedit pilihan rover GPS:
» Pilih Rover options.
» Tekan Edit.

¥o survey PDOP:2.6

| store |
Esc Seirhto atm Al
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3. Default Rover parameter seperti dibawah:

« Survey type - PP Kinematic

» Logging device - Controller

» Logging interval - 15 seconds

» Elevations mask - 13 degrees

« PDOP mask - 6.0

« Masukkan default tinggi GPS antenna

« Pilih GPS antenna type ’
Tekan ke bawah untuk melihat detail antenna yang lainnya.
Roveroptoms & €235 Q
- &
-.- @o Hhe names

Elevalon mash SDOR mask,

13°00°00 I»] [0 »
Amenna l
[N‘!HNLA L !
{2.000m [s] |
Type: -
Tnmbse A SN 3

Wo survey POOP2.4

Esc  SaRchito Acceot Al

4. Pilih metode pengukuran tinggi GPS antenna, dan simpan perubahan yang
dilakukan untuk rover option:

« Pilih Bottom of antenna mount jika menggunakan pengukuran tinggi GPS

antenna sebenarnya.

» Tekan Accept.
R OTY
| Measured to:
|[Bottom ot antenna mount] v |
Part number: Seral number:
S3406.00 I

Mo survey PDOP:2.6

Esc Spirhto Al
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5. Untuk mengedit pilihan Base station GPS.
« Pilih Base options.
» Tekan Edit.

fof| PPK o 1043
2 (}77 > B

Rover oplions
Base opuons h

| swre |

Bx Swechto | Ex , A

6 Default base station parameter seperti dibawah:
« Survey type - FastStatic
« Logging device - Controller or Receiver
« Logging interval - 15 seconds
» Elevations mask - 13 degrees
» Masukkan default tinggi GPS antenna
« Pilih GPS antenna type

Tekan ke bawah untuk melihat detail antenna yang lainnya.

Base oplioms S 4236

Vo 2 B R

Survey 2 devee:

o memen]] (R ]
Qg ntenvak: Auto fle nemes:

[50s |~ 3]

Elevaton mask:

130000 »

neghe:
z 103}

Type: I'

o survey POOP24

s s, Al
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7. Pilih metode pengukuran tinggi antenna. Antara lain:
» Bottom of antenna mount : vertical height measurement to base of threads -
(Trimble A3, Zephyr, etc)
« Top of notch : slant height measurement to edge of ground plane - (Zephyr
Geodetic antenna)
« Antenna Phase Center : height measurement to electronic phase center of
antenna.

Tekan Accept

8o survey POOP24

Ex  Smtchto  Acowt, Al

Tekan ESC untuk kembali ke menu PPK survei style.

8. Kemudian lanjutkan mengedit pilihan untuk pengulauruan point survei Topografi:
« Pilih Topo point.
» Tekan Edit.
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9. Default untuk Topo point adalah:
« Auto point step size - 1
« Quality control - QC1
« Auto store point - Yes
« Occupation time - Om5s (5 seconds)

« Number of measurements - 3

Tekan Accept untuk menyimpan perubahan.

==L - R -

Lyto pont step see:
]
I

control:
stone post: Oocupation tme:
omss  ]»]

fNumber of measurements:

Ko survey PDOP:2.6

-

Esx Swichto WI!A‘

Catatan:
« Jika kotak Auto Store point dipilih, maka point akan disimpan secara otomatis
jika sudah selesai.
= Auto point step akan otomatis bertambah 1.
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10. Untuk mengedit pilihan untuk pengukuran kontrol point:
« Pilih Observed control point.

« Tekan Edit.

WO survey PDOP2.6

|_store |

Esc Seirhto e, Al

11. Default untuk sebuah pengamatan control point:
« Auto store point: = No
e Quality control: = QCl1
Default observation times:
e Time for 4 SVs = 10 minutes
* Time for 5 SVs =8 minutes
« Time for 6 SVs =5 minutes

Tekan Accept untuk menyimpan perubahan.
/75| Observed control & o€ 10:45 )
A TY > §

Ex Swtchto ‘%Al‘

Catatan - Trimble tidak menyarankan untuk mengaktiikan Auto store point
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12. Untuk mengedit pilihan untuk waktu initialisasi:
» Pilih PP initialization times.
» Tekan Edit.

PPN GIRZABDN Mg

13. Defaults untuk L1 new point initialization times:
« Time for 4 SVs =30 minutes
* Time for 5 SVs =25 minutes
» Time for 6 SVs =20 minutes

Tekan Accept untuk menyimpan perubahan.

=

PP sl kzaton te :‘

“O1Y

el

Catatan - Waktu initialisasi adalah jumlah perkiraan data yang cukup untuk prosesing.
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14. Untuk menyimpan semua perubahan pada PPK survei style:

s TekanStore.

ST’ »

Rover options
Base options
Topo point

%o survey POOP:26

ex Soache L ex , Al

15. Untuk kembali ke layar menu utama:

= Tekan Esc.

£ -survey Styles
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3.3.5. Membuat Job Baru

Setelah pengkonfigurasian

parameter-parameter style telah dilakukan

kemudian dilanjutkan dengan pembuatan job baru, sebagai tempat penyimpanan data

lapangan.

Berikut adalah langkah-langkah untuk membuat job baru.

1. Untuk membuka menu File dan layar menu utama:

Tekan Files icon

o di022 i

:L..m
1 %10

Cogo nstrument

5:7] Jobi (L6 1705 -

Yo survey POOP2Y

2. Pilih New job dan list menu.

O8Y
Open job
Review current job
Mao of curent job
Properties of cument job

B St e

s
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3 Beri nama dan simpan job yang baru:
« Tekan Keyboard icon untuk membuka keyboard.
« Ketik nama iob, nama terserah pengguna, hanya sebagai ID pembeda saja
» Tekan Enter.
« Tekan Accept untuk menyimpan job yang baru.

Feature ibracy o %

ilalwle|r|t]|y i|{o|p|e
a|lsid{T|Q Jik Lo
zlxlc|v

3.3.6. Membuka Job yang Sudah Ada
Berikut ini langkah-langkah untuk membuka job yang sudah ada:

1. Untuk membuka menu File dan layar menu utama:

» Tekan Files icon
« Pilih Open Job dari list menu

41



» Pilih job yang akan dipilih.
* Tekan Select.
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3.4. Pengambilan Data Lapangan
a. FastStatic Survey
Memulai FastStatic Survey
Berikut ini langkah-langkah untuk memulai Faststatic survey.
1 Untuk memulai FastStatic survey:
» Tekan Survey icon.

« Pilih FastStatic survey style.

¢l

fres Keyin Configurabon |
PRK... % "
X
Survey Cogo instrument

Mo susvey PDOP:25

Bx  Swechto  Enter , A

2. Dari pilihan menu:

» Pilih Start base receiver

Start survey
Measure ponts
End survey

Ho survey PDOP:2.6

B&X Swyechto Enter |, Al
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3. Pilih tipe antenna dari list menu:

« Pilih tipe antenna.
» Tekan Enter.

57 Setect antenna typ & o€ 345 €

46001 S Internal

o survey POO™2.5

Ex Suidchio f'_*"'Al'

4. Masukkan nama point yang akan diukur:
« Ketik nama, atau tekan panah kanan untuk memilih dari point yang sudah ada.
Sebuah pesan akan muncul. Anda diminta untuk menyediakan koordinat point

pada saat prosessing.

e Tekan OK

Catatan - Jika koordinat point sudah ada maka pesan tersebut tidak akan muncul.

;" Point does not exist. Provide
S coords at processing time H

Mo survey PDOP:2.5

Esc  Swirhto Enter , A~

5. Masukkan informasi yang lainnya:
« Masukkan tinggi GPS antenna.
» Pcriksa cara pengukuran tinggi antenna.
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Untuk memulai survey:

» Tekan Start.

6. Pada layar akan muncul:

snnbue —odi 1055 ©

. Ve 2 B T

Font name: Cooe:

?
jobsenvation clss:
AUtonomous

Zntenna heght (Uscor,
EF..EE-D

[Measured to.

Boriom ol antenna mount £

Wo survey POOPZS

Ex Spirhto —Eim‘

« Waktu yang telah berjalan.
« Perkiraan jumlah memori yang tersisa.

Base S 4150
I OTTaom B

200 0x. memony keft:

Pont:
Baset

Time s¢ far:
3ml2s

1327h8m30s

Baae survey PDOP2.5

Swechto | End , Al

Untuk mengakhiri Faststatic survey:

Tekan End.

Base swrvey POOP:2S

Syfitch to ed , Al
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b. PPK Survey

Memulai PPK Base Station Survei

1. Untuk memulai postprocessed kinematic (PPK) base station survey:
« Tekan Survey icon.

» Pilth PPK survey style.

Fast StatC... | !

Survey Cogo Instrument

Ho survey PDOP:1.0

BX  Syichto Enter , A

2. Dari menu.

e Pilih Start base receiver.

Keyin Caﬁm
Start base receer

Start survey
Measure ponts
Continuous tope

Survey End survey

Mo survey PDOP:3.0

Bt  Switchto Enter , A~




3. Masukkan nama point yang akan diukur:

« Ketik nama, atau tekan panah kanan untuk memilih dari point yang sudah ada.

Sebuah pesan akan muncul. Anda diminta untuk menyediakan koordinat point

pada saat processing.

e Tekan OK.

Ex Swchto  Enter , Al

Catatan - Jika koordinat point sudah ada maka pesan tersebut tidak akan muncul.
4, Masukkan informasi yang lainnya:
« Masukkan tinggi GPS antenna.
» Periksa cara pengukuran tinggi antenna.
Untuk memulai survey:

» Tekan Start,
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Pada layar akan muncul:
« Waktuyang telah berjalan.

« Perkiraan jumlah memori yang tersisa.

447012m30s

Base survey PDOP:2.9

Sechto Eﬂll. . Al

¢. Memulai PPK Rover Survey

ST
€S

fhes Keym Conhgurauon

Sl

Tekan Survey icon.

Instrument

Ho survey PDOP:2.6

Bt Swykchto Enter , Al~

2. Dari list survey styles.
« Pilih PPK survey style.

mems = <10 O

T 6T e i

el &

iPdes Key in Confguraton |
| ek B
= ———c—w M,
Survey Cono nstrumen

Ho survey PDOP2S

|

EXt  Swch to Enter , A~
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3. Dari menu.
Pilih Start survey.

d. Initialisasi Dengan Metode New Point

Initialisasi dengan metode new point dilakukan sebelum pengukuran dengan
metode topo point, dikarenakan untuk meminimalisir kesalahan pada saat
pengukuran,dimana alat harus harus menunjukan fixed pada saat digunakan, sebelum
alat menunjukkan fixed atan masih dalam keadaan float maka alat tersebut belum bisa
digunakan untuk pengukuran topo point.
1. Untuk memilih metode new point initialization.

Pilih New Point dari menu.

\ASSLISE °
Bottom of amenna mount] v}

PP et PDOP29
Optiors |

!Esc Swichtn |, sat , Al

2 Untuk set up new point initialization.
« Masukkan nama point untuk initialization point.
« Masukkan feature code, jika diperlukan.
« Periksa atau masukkan tinggi antenna.
s Periksa metode pengukuran antenna.
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Untuk memulai initialization.
+Tekan Start.

o 6 Yo g

" wbanzation n 19mles .
Do |

| Ex  Symchto : Al

Setelah penghitung waktu selesai maka tombol Store akan muncul. Untuk menyimpan
initialization. Tekan Store.

PPK:fixed POOP:Z.7

lex  swchw  _Swoe, A

Catatan - Apabila initialization sudah tersimpan, maka akan muncul otomatis
“PPK :Fixed” dan alat sudah siap untuk melakukan survei.

50



e. Pengukuran Topo Point dengan PPK Rover
1. Untuk memulai pengukuran point dengan PPK rover:

« Tekan Survey icon.
« Pilih Measure Points.

ssssss

2. Masukkan informasi point:

 Masukkan nama point.
» Masukkan feature code.

» Set the Method - Topo point.
» Masukkan tinggi GPS antenna.
» Periksa metode pengukuran tinggi antenna.

» Tekan Measure.

Blr—ree > i1
T 6 Yo g

Cont name Coge:

Topot PIE I
Meathod:

Topo pont _I:}

fntenna heght {Jncor)
{2.000m D

Measures To:

Bottom of amtenna mount [+ |

PRK:fied PDOPZ 7

_Opoons|
Esc  Swechto M&AJ-

51



3. Pada layar akan muncul penghitung waktu pengukuran point, apabila sudah
disetting “auto store point™ maka point akn langsung tersimpan jika penghitung waktu
menunjukkan angka 0. Jika tidak “auto store point” maka point akan disimpan secara

manual.
e 1
s = 1= O
= Pl Y oo g 7 .
mtnore e
e D D
e ? ™
1000 point .
Lntenna et t K<
2600m  [»’
e o e T

Jhotiom of amvina mavei| e
Tt ‘A LN remanw,

mgs «

Lo

Dow tined VNP . T

Options

———

B S A‘-J

Setelah point tersimpan, nama point akan otomatis bertambah satu. maka dapat

melakukan lagi pengukuran point seperti langkah diatas.

s
(7] Mensure poimts & 4€ 1126 i

L anlly¥ o e
Topoi [sl & !
tagmenegs
Topo pant lv) i
Antenna R T )
P O !
[Botiom of amenna moum]~] !
|

PO Fiaed PDOP2 7

Ovors |

et Swmchto  Measwe, A

4
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Setelah pengambilan data selesai maka perlu menonaktifan alat agar data tetap
tersimpan pada memori alat, perlu diperhatikan jangan sampai alat nonaktif dengan
sendirinya, yang dapat berakibat pada hilangnya data atau kerusakan pada data
tersebut.

f. Mengakhiri PPK Rover Survey
Untuk mengakhiri PPK rover survey:
« Tekan Survey icon.
» Pilih End survey.

g. Mengakhiri PPK Base Station Survey
Untuk mengakhiri PPK base station survey:
Tekan End.
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h. Menampilkan Layar Peta
Layar peta menampilkan semua point yang ada dalam job tersebut dan dapat
menampilkan point-point tersebut kapan pun.
Untuk membuka layar peta:
« Tekan Switch to.
» Pilih Map.

fastsianc pomi]~-

farcanns nagme
Jzoooe e
o=

Honom of an™

o Oceupat o t > *
IR = -
Hrewe L.
I

‘et

2 Untuk memperbesar atau menggeser peta:
» Tekan icon dibawah Iayar.
Untuk menutup layar peta:
« Tekan Esc, atau tekan Switch to untuk memlih layar lain yang sedang aktif

Zr| Map of current jo! o~ s 1118 O'.

8 0 3 07Yl. )
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PENGUKURAN DETAIL

PPK SURVEY

PERSIAPAN

3.5. Diagram Alir Penelitian

ORIENTASI MEDAN

:

PENGUMPULAN DATA

PENGUKURAN POLIGON

LN gl 7

LAl R r.Ivo w

I R N e

-

: : :

%] Q

: 2|l f ol E|— B

= IAnE

g

: : g
11 I m
T REARE: " 2
i




Penjelasan Diagram Alir Penelitian :

l.

3.

Persiapan pelaksanaan penelitian meliputi peralatan survey, hardware,
dilakukan.

Orientasi medan yang dilakukan yaitu melihat atau men-survei daerah yang
akan di survei

Pengumpulan data dibagi menjadi dua yaitu pengukuran poligon dan
pengukuran detail, menggunakan dua metode yaitu dengan cara fastStatic dan
postprocessed kinematik survei.

Faststatic survei dilakukan dengan lama pengamatan tergantung dengan satelit
yangditeﬁmapadasaatpengamamn.Contohnyakeﬁkapadasaatpengamatan
satelit yang ter-cover ada 4 satelit dilakukan pengamatan 30 menit, 5 satelit =
25~menit,6=l$menit,un&d(koverpaéametodeini-,halinidﬂakukan
sebagai kontrol point

Postprocessed  Kinematic survei dilskukan dengan lama pengamatan
tergantung dengan satelit yang diterima pada saat pengamatan. Contohnya
keﬁkapadasaatpengamatansatelityangter-eoverada4sateﬁtdilakukan
pengamatan 10 menit, 5 satelit = 8 menit, 6 = 5 menit, untuk Rover pada

metode ini, hal ini juga dilakukan sebagai kontrol point bila menggunaian
metode ini.

Base Receiver dan Rover Survei waktu pengamatan harus saling singkronisasi
antara keduanya.

Untuk metode PPK survei, Rover harus di Initialisasi new point dulu yaitu
metode pada alat yang dilakukan utuk penyiapan alat untu pengukuran topo.
Setelah semua data terkumpul dilakukan transfer data dari alat GPS ke
komputer.
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BAB IV
ANALISA HASIL DAN PEMBAHASAN

Pengukuran Topografi merupakan langkah awal dalam suatu pekerjaan untuk
menuju tahap Eksploitasi suatu dacrah Tambang. Yang mana hasil dari pengukuran
terscbut dapat berguna dalam tahap berikutnya yaitu tahapan festspeed titik —titik
borhole yaitu untuk mengetahui kandungan nikel yang ada pada daerah tersebut.
Sehingga elevasi dari hasil dari pemetaan topografi sangatlah dibutuhkan dalm
pekerjan ini.

4.1. Analisa Hasil

Peta yang digunakan adalah peta dengan skala 1:100.000 pada dacrah rencana
pengukmantopogmﬁyangmemuatlmsuralamdanbuatanmanusiayangdiambﬂ
sesuai kebutuhan pada saat pengukuran di lapangan. Informasi yang di tampilkan
pada peta seperti batas area tambang, jalan, sungai serta informasi yang lain.
Titik-titik tinggi yang disajikan dalam bentuk point dan label sehingga apabila
diwakili dengan garis pada titik dengan ketinggian yang sama maka akan terbentuk
garis kontur dengan interval 0.5 meter schingga daerah pengukuran dapat dilihat
lekukandankemiringannyasecaradetaﬂmmkkepeduanperéncanaan.

Unsur ketinggian yang sudah berupa garis kontur merupakan elemen utama
dalampeneﬁﬁanhﬁselaininfomasihinyangkemudiandigmkanunmkbahan
pertimbangan dalam tahap eksploitasi.

4.2. Analisa Pengukuran

Proses topografi yang dilakukan menggunaksn data awal berupa peta
topografi Kabupaten Halmahera Tengah dengan Skala 1:100.000 yang diperoleh dari
Bakosurtanal. Melalui peta dasar inilah dilakukan penentuan titik-titik koordinat grid
pengukmandenganjmkgﬁdSOmeteryangkemudimdﬂakukanpmgmnpulmda(a
elevasi melalui pengukuran secara Geodetik.

Pengumpulan data elevasi dilakukan juga terhadap daerah ekstrim seperti pada
titik tertinggi dan titik terendah yang ada pada lokasi seluruh areal yang dipetakan
dengan kerapatan grid 50 meter dimana titik acuan adalah titik Base Line yang saling
terikat dengan Bench Mark. Melalui grid dengan jarak 50 meter ini dapat diketahui
koordinat tiap-tiap titik, dimana titik-titik koordinat tersebut merupakan perpotongan
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dari garis-garis horizontal dan vertikal yang ada pada grid tersebut. Dengan metode
ini akan memudahkan pengambilan data dengan menggunakan GPS Trimble R3.

Titik Base Line Grid 50 meter
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Gambar 4.1. pengukuran dengan Grid 50 m

4.3. Pengolahan Data

Hasil pengukuran diperoleh dari semua titik-titik koordinat grid pada daerah
pengukuran yang berupa koordinat X dan koordinat Y serta data ketinggian (elevasi)
kemudian ditransfer ke komputer dengan menggunakan software Data Transfer. Data
tersebut akan diolah dengan menggunakan perangkat lunak yaitu Trimble Business
Center sehingga hasil pengukuran semakin akurat. Tujuan pengolahan data ini adalah
untuk mendapatkan ketelitian data ( X,Y,Z) agar dapat digunakan dalam tahap
selanjutnya, transfer data yang terjadi dapat dilihat melalui entry data atau transfer
data melalui kabel data USB. Dengan cara :

a. Klik Software data transfer dari menu strat atau dari icon di dekstop

b. Sambungkan GPS receiver dengan komputer dengan kabel conector
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c. Apabila sudah tersambungkan klik connected to GIS Datalogger on Windows
CE dari menu device

d. Klik Add kemudian pilih data Dectionary, dari menu dectionary pilihlah data
yang ingin ditransfer

e. Setelah memilh data klik send untuk mentransfer data tersebut ke komputer

f. Save data yang sudah ditransfer ke komputer.

[~ Device m; 0 -
{615 Datalogger on Windows CE = |§|}0 :Dgl Devices... | :__.—'—‘!,ld)-.b—-‘.
e e = = = Transfer files dari
Connected to GIS Dataloggeron |1
Receive Serd [ Windows CE. > GPS ke komputer
- Files to Send- |
o DAL L =
Data File
Waypoint
Background
Configuration .
Coordinate System Tipe file yang
Coordinate System Export File ingin ditransfer
Other
T Retein File List for this Data Transfer Session |
setings.. | Hep | Oose |

Gambar 4.2. Transfer data dari GPS ke Komputer

4.3.1. Trimble Business Center

Setelah data ditransfer ke komputer kemudian diolah melalui komputer
dengan perangkat lunak Trimble Business Center ditambah USB Key (Dougle)
sehingga bentuk koordinat-koordinat X,Y,Z dapat diperoleh. Kerapatan kontur
disesuaikan terhadap skala peta yang akan dihasilkan, dalam hal ini peta topografi
yang diinginkan adalah skala 1 : 1.000 dan hasil kontur yang dihasilkan dengan
kerapatan 0.5 meter.

39



_— A
s P o

e . e e

oA
</
= \k{u&.:.;'

AN

ey
Trimble® Business Center 1 :'
SR p— L " ; "::;
i
“ { " ol
e o e o L L
o (to .2 n
- -
T L —
iy S0l o £ - g T L

Gambar 4.3. Halaman muka Trimble Businees Center

a. Buka Trimble Business Center Basic untuk merubah extension csv. ke bentuk

format dat.

Langkah pertama buat file baru :

« Klik File > New Project> Blank Template > OK

Lalu masukan data yang akan diolah dengan import Data:

e Project> Import

(Jika file sudah disimpan didalam komputer dengan format ASCII point)
Maka akan muncul kotak dialog Import.

Celect Tike

| Fi= Name Fis Typm

| IMNDUKE MERRUR cav PCocks NLE sdavy
| R TRS cav P Cocks MN_E sl
| etk IRER caw P Corks N_E _slev
| e sav P oxs Nt _wiery
| Paflarens Desbon OS5V P.Cote N_E _sav

& J(conom ]
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« Browse import folder untuk mencari data yang akan diimport.
« Klik view filter icon untuk memperlihatkan tipe file yang ada.
« Pilih file yang akan diimport, kemudian klik OK

Maka akan muncul kotak dialog Custom Import Editor.

% Custom import Edilor - P Code N[ clov

D efinition Name Resd Oy Esrmresion Stose Poirt Ax Show Editor [ N o ]
3
P ENwwesoe e R s S
opyeraonaney S DI L ==J
F.LL. R Lode Boosll LT X s == i o »
P NLCstew Code -~ 4 P T iy
C weer J[Cmem J[Come ]
LR o LA S L M BTt i tnt, S e LU UL i Reed Fia -
mm
e n
Powrt id Nortteng Esstng E lovalion Feshusre Code
» © ITHIBTS BIE e33199 64 29 669
b IZHIESI BTN ¥3I3220 568 29439
- ATSIOET 707 IR 550 9416
F o Viow
——
C. 9259625 636.593199.654.23.669.
b, 9259859.891,833220. 568,23 479,
- 9289952 707693164 559,23 416,
—
— -

« Klik Import untuk memulai proses import.
b. Langkah selanjutnya mengganti nama point atau objek.
» Select> Select All
Maka objek yang terpilih akan ditampilkan dengan warna merah.
« Edit > Rename Point

Maka akan muncul kotak dialog Rename Point.

Unzelect At
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» Masukkan point ID pertama

« KIik Preview untuk melihat hasilnya sebelum mengganti projectnya.
« Klik OK untuk menyimpan hasilnya

« Rename Point akan ditampilkan dalam display browser.

D e shesdn.id LISSEEDCIEREY: "}
- - O - . -0 =Y
ibamation Lo:-l-—o,—
arme. ene Delmt
Suze WS 1984
bt - E: Defik
{Reforonce musber
md— J

. RevmmedFrom 1 RessmedTe
i T W SRR
L i B2 !
S A - R
[Dee 3172006 4 1430 P i " Propm 7 Tonble Bussrss Conse|

« Tutup display browser untuk kembali ke project.
« Seluruh point sudah memiliki ID yang berbeda (unik)
c. Setelah menganti nama point cek kualitas data
« Klik Project Explorer.
« Klik Pin icon
« Pilih Point, pilih sebuah point klik kanan pilih Propeiiics.

LA B 2 N 4 2

e 1 [} mSNaMIie s}

62



d. Pilih Coordinate System
* Project> Project Setting> Coordinate System> Change

Maka akan muncul kotak dialog Select Coordinate System.

Select Coordinate System
Smhm&mm&ummhmm“dﬁph]hhﬂm

systerms used ax shown below, then press Finish Alematively select New System' in
choose a diferent coordnate system and then press Next to continue to the next
page

(@Hew Systom
(O Becently Used System

» Pilih New System > Next
« Pilih Coordinate System & Zone > Next
* Pilih Coordinate System Group & pilih Zone > Next
» Pilih The Geoid Model (No Geoid Model) > Finish
e. Buat Control Quality Coordinate
* Klik kanan pada titik yang dijadikan titik control > Add Coordinate
Maka akan muncul kotak dialog Select Coordinate System

9259852.707 m
a33184.561 m
29.476m

SBT40'59. 46438
E108°3318.81736™"
23,416 m

SET40'58.46438"
E108°3318.81736"
29.476m
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« Pada Coordinate Type pilih Global
» Set koordinat ke Control Quality
Maka Control Quality icon akan muncul
« Klik OK> Close

d. Melihat data point di Spreadsheet
» View > New Points Spreadsheet

Maka akan muncul kotak dialog Points Spreadsheet

Poirt Sprmadshest |

Poirte
Powd ID W Northerg W E asteng T

BM 2 DILWBSY HEY m
R 3 AINADT AME

WIIZ2U. BTV Z3 439
RAXIAN GOF r. IARRA .

e. Export Data
» Select> Select All
» Klik Export icon.

Elovation W Featuse Code

S e T S e B e e L e e e e S S s

R
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« Klik Custom untuk melihat export format yang tersedia.
« Isi nama file > OK

» Klik Plan View untuk kerabali ke project.

4.3.2. Trimble Business Center Post Processing
a. Buat file baru :
» File > New Project > Blank Template > OK
Pilih Coordinate System '
» Project> Project Setting > Coordinate System> Change
Maka akan muncul kotak dialog Select Coordinate System.

Select Coordinate System

Select the coordnate tyitem thal you want L0 ute om one of [up to] the last 10
sysiems used a1 shown beolow, then pross Frvsh. Aematvaly seloct How Systom’ to
choote a cfferent coordnate system and then press Nesd 10 contmue (0 the newt
page
Hlew System
O Fecenty, Used System
* Mot > | Cancsl
)| |
» Pilih New System > Next

« Pilih Coordinate System& Zone > Next
» Pilih Coordinate SysTem Group & pilih Zone >Next
« Pilih The Geoid Model (No Geoid Model) > Finish

b. Hubungkan device (Donggle) ke komputer (Melalui Microsoft ActiveSync)
« Jika sudah terhubung maka akan muncul kotak dialog Device.
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c. Import data dari device

) Cimcos Cliemet Connact &> |

Device:
[ - 3 f{@{ Tasks -
[EEE T

\Built-in Storage’\Trmble D ata'\
V2.0

« Klik (+) didepan gambar device
Maka akan muncul job-job dan file .DAT yang ada di dalam device.
« Klik file .DAT yang akan diimport dan drag ke Plan View. (Bisa langsung dari

desktop atau windows explorer)
« Maka akan muncul kotak dialog Raw Data Check In > OK

eceiver Raw Data Check In

JaiTeers

. e S SR L S

[— Pont 10 FlaNam Stat Time End Time Dusation Festise Cods

@ MAGSE0de 27242005 BASTRY 272472005 T3 47PM W20 Hak

| 2 MeESHIdy 27U TIZATRR 22472005 1 B1TPM 053] 152

B 3 GUUE0SS0ds | 2005 TA1 LT 22472005 B 13 02 PM 002115 153

‘| ¢ MUG0SE0de 25 BIZETRY NS RER RPI 001945 Hal

Port | Arterra | Rocaver R
(Chet ] l_—[g

« Hubungkan device data base receiver dengan komputer, import data from GPS

base.

« Maka akan muncul kotak dialog Raw Data Check In > OK

« Maka akan muncul project dan potensial baseline.
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1. Processing Baseline
» Klik ( +) didepan Session

» Pilih salah satu session, klik kanan > properties.

» Session yang dipilih akan ditampilkan dan muncul kotak dialog properties.

e
8 asehé
o  159--1(B4)
8 1) General ~|
Frocessng Status
Start Time: 272472005 6:43:47 P
End Time: 2/24/2005 7.03.47 P
B 2) Pount |
Height: 1.305m |
Methad. Top of notch i
7 Manutacturer: Trimble !
, Type: Zepma
8 31Pont 2
Height: 1817m
Method: Bottom of anterma mx
Manuf acturer Trmble
~ Type: A3 Vi
Prucesi'mg Status [ i
The processing status of the baseline. :

| Clese ! |

* Survey > Process Baselines

Maka akan muncul kotak dialog Process Baselines.

T Process
Save Observoion SokdnTipe  Hose Precison (5% Vert Precision (55Y] Lengh
i Sebrgn
0df 3 pocesesd
Proas (Process> o o procensing. o i




« Klik Order untuk melihat baseline yang akan diproses.
« Klik Process.

» Jika processing telah selesai klik Report.

+ Klik Save dan compute the project.
Untuk melihat data vector

« Klik New Filter, pilih Processed Vectors

« Baseline yang telah diproses dinamakan vector dan ditampilkan dengan wama

biru.

« View > New Vector Spreadsheet
Maka akan muncul tampilan Vector Spreadsheet.

Cek kualitas hasil vector processing (loop closure)

Survey > Loop Closure
Maka akan muncul tampilan loop closure report.
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Network Adjusment
Survey > Adjust Network
Maka akan muncul tampilan Adjust Network.

* Klik Setting
- Isi error in height of antenna =..... mm.
- Centering error =...... mm.
« Pilih 1 titik fix untuk horizontal dan 1 titik fix untuk vertikal.
« Klik Adjust.
Untuk melihat hasilnya klik Report.
» Save.

2. Processing Kinematic Data
Buat project baru
¢ Klik New Project icon
Kemudian import data
« Klik Import Data icon
« Pilih data yang akan diimport.
¢ Drag file ke Plan View.
" Maka akan muncul tampilan Receiver Raw Data Check In
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» Setelah cek semua data, klik OK untuk proses import.
Melihat data yang telah diimport.

» Klik ( +) didepan Session
Kemudian Process

* Survey > Process Baseline > Process

Maka akan muncul tampilan Processing Result.

Processing Results

Obsarvation Salution Type Hoaz Precison [95%) Vet Pracinon [35%] Length *
0oco Fued QC1?m 0.2¢9m B2AX1Im Cance!
00002 Fved aci’m 0.048m 29431m -
s s i e it
00004 Faed 001 7m 0.049m 536852 m -
00005 Fixed ati?’m 0049m 60862 m D
00008 Fiend 0017 m 0049 m 57320 n —
e[t eerg Foved act7m 0.328m 73861 m m
00008 Foeed a7 m 0.343m 8019 m
00009 Foeed 0017 m 0.049m 7455
00610 lrm:irh B 0049m 94575 m

e processing results display.
ooon Irend P a DId e i 0.0:8m uRE: ]
ooo12 fued  aotrm 0.048m 105408 n
ooc13 Fared af7m 0.343m “10405
o014 Freed Q017 m 0.049m *1711%m ot —rw—
00015 (] o7 m 0049 m B "“‘“’T‘;T‘—'“
s5ing rends B ) ) imehm

» Klik Report untuk melihat detailnya.

» Klik Save untuk menyimpan data dan meneruskan proses perhitungan.

Setelah proses processing slesai atau data telah menunjukkan Fixed maka data
tersebut disave dalam bentuk ‘dwg’ agar bisa diolah kembali dalam software Autocad
Land Dekstop untuk menampilkan permukaan (surface) dari kontur dengan enterval
0.5m. Serta pembuatan peta topografi dengan skala 1 : 1000

Hasil pengolahan data dengan Trimble Business Center berupa data-data

koordinat X,Y dan Elevasi (Z) dapat dilihat pada Lampiran A.
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4.3.3 Autocad Land Dekstop
Setelah pemrosesan data dengan Trimble Business Center telah Fixed, data
tersebut kemudian diolah dalam Autocad Land Dekstop.
» Klik Autocad Land Dekstop dari menu Strat atau Dari Dekstop computer
= QOpen data dari nama project yang telah disimpan dari software Trimble

Business Center

»  Kemudian koordinat-koordinat hasi pengukuran akan muncul, seperti gambar

dibawah ini :

1@ AutoCAD 2004 - [D:Mitip End\Skripsi\embr smpn 2004\KP2 all New_ 2004 dwg]

§) Fle EGt View lsert Fomat Tools Draw Dimension Modfy Window Hep -2 %
DREH 808 =006 »# XX RnERGE & Wi

Bt e € O e o
/ " 4
7 2
o db
&) &
=} &a
rl +
ol O
8 ol
d i
o 7
(} -
| O
B | L1
; i
o) &
Y o
A

Comnand: '_pan A
Press ESC or ENTER to exit, or right—click to display shortcut menu. v

< »

Shows how the drawing wil ook when § i printed or plotted. PREVIEW

T} B4E 41 - Morosolt ..

Gambar 4.4. koordinat-koordinat hasil pengukuran
ditampilan dengan software Autocad Land dekstop

= Setelah koordinat-koordinat tersebut di import, kita bisa membuat kontur dari

elevasi yang ada.
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{@] AutoCAD 2004 - [D:\itip End\Skripsi\gmbr smpn 2004%P2 all New_ 2004.dwg)
E) Fle Edt View Insert Format Tools Draw Dimension Modfy Window Help
DR 8@ =BG 2 (- ke RER @ & s«

I v 4, Standad v
oo v = €  Dejye b

Hj.g_yu v —— Blaer v

PR IDOOTOONDOLNN

Bylayer

LPHEICHEEMP B el K

RICD L

[AutoCAD menu utilities loaded
Comnand: Specify opposite corner:

Gambar 4.5. kontur dari elevasi ditampilan dengan
software Autocad Land dekstop

Hasil gambar dapat dilihat dalam Print A3 pada Lampiran B.
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BAB YV

KESIMPULAN DAN SARAN

5.1. Kesimpulan

Dari penelitian yang telah di lakukan ini diambil beberapa kesimpulan sebagai

berikut:

1.

5.2.

Pengukuran topografi skala 1 : 1000 dengan mengoptimalkan GPS Trimble R3 dapat
menghasilkan koordinat-koordinat dan elevasi dengan ketelitian + 20mm

Dengan menggunakan GPS Trimble R3 pengambilan data dilapangan dapat
dilakukan dengan mudah dan cepat (efisiensi waktu) sehingga tidak memerlukan

waktu yang relatif lebih lama, data hasil pengukuran juga dapat dipertanggung

jawabkan ketelitianya.

. Dari hasil tersebut didapat elevasi titik koordinat yang digunakan untuk fesspeed titik-

titik borhole untuk mengetahui kadar kandungan nikel didaerah tersebut.

Elevasi-elevasi tersebut juga digunakan sebagai acuan deposit nikel

Saran

. Dengan semakin berkembangnya alat, khususnya GPS maka perlu adanya

pengetahuan tentang GPS dari awal agar tidak ketinggalan dengan Aplikasi software
atau GPS yang ada.

Perlunya pengetahuan tentang pengaplikasian peta pada suatu perencanaan tertentu
sehingga sebagai seorang geodet (pembuat sekaligus penyaji peta)‘ harus mampu
memberikan semua informasi yang dibutuhkan untuk keperluan perencanaan tertentu

Perlunya peningkatan pengenalan serta penguasaan software melalui media
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praktikum maupun pelatihan-pelatihan kepada mahasiswa, agar dalam pengerjaan
Tugas Akhir tidak mengalami kesulitan atau kendala.

. Perlu adanya penambahan literatur tentang sofiware-sofiware Geodesi maupun
sofiware-sofiware pendukungnya karena selama ini susah mendapatkan literatur-

literatur tersebut sehingga harus mencari ke tempat lain.
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50 m GRID TOPOGRAPHIC RESULT

1 P 161 P101 383.500 81.750 370
2 P2 102 P102 383.550 61.750 38
3 F3 103 P03 383,600 61.750 tﬁ#
4 P4 104 P104 383,650 61.750 418,
5 P5 105 P105 383.700 61.750 428244
8 ) 381.800 61.700 190,195 108 P108 383.750 61.750 430,828
7 [ 381.950 51.700 191,414 107 P107 383.800 61.750 451,409
8 P8 382.000 51.700 182,938 108 P108 383.850 61.750 462,382
9 P9 382.050 §51.700 194,158 109 P109 383.900 61.750 471,830
10 P10 382.100 81.700 195,662 110 P110 383,950 61.750 480,574___|
1 P11 362.150 61.700 196,801 111 P111 384.000 61.750 490,423 |
12 P12 382.200 61.700 196,425 112 P112 384.050 61.750 504,139 |
13 P13 382.250 61.700 199,644 113 P113 384.100 750 521,818
14 P14 382.300 61.700 200,863 114 P114 384.150 61.750 539,801
15 P15 382.350 61.700 202,387 115 P115 384.200 750 557 479
18 P18 382.400 61.700 203,911 116 P116 384.250 61.750 566,318
17 Pi7 382 450 61.700 208,950 117 P17 384.300 81.750 569,062
18 P18 382 500 81.700 210,007 118 P118 384.350 61.750 581,558
19 P19 382 550 61.700 13,055 119 P119 384.400 81.750 589,483
20 P20 382.600 61.700 216,408 120 P120 384.450 81.750 601,980
21 P21 382.650 §1.700 219,456 121 F121 384.500 61.750 614477 |
2 P22 382.700 81.700 504 122 P12 384.550 1.750 633,984
23 P2 382.750 61.700 226,771 123 F123 384 600 61.750 643,738
24 P24 382.800 61.700 235 610 124 P124 384 650 61.750 651,662
25 P25 382.850 61.700 244,754 125 P125 384.700 61.750 653,49
26 P26 382.900 61.700 263,594 126 P126 384.750 61.750 654,406
27 P27 382 950 81.700 262,433 127 P127 381,650 61.800 210,007
28 P28 383.000 61.700 251,785 128 P128 381.700 61.800 208,702
29 P29 383050 1.700 258,470 129 P129 381.750 61.800 209,398
30 P30 383.100 1.700 271,882 130 P130 381.800 61.800 209,083
31 P31 383.150 61.700 284,378 131 P31 381.850 61.800 208,788
2 Pa2 383200 61.700 296,570 132 P132 381.900 61.800 208,483
3 P33 383.250 61.700 300,372 133 P133 381.950 61.800 207,874
34 P34 383.300 61.700 319,430 134 P134 382.000 61.800 207,569
35 P35 383.350 61.700 331,318 35 P135 382.050 61,800 207,264
38 P38 383.400 61.700 347,167 138 P138 382.100 61.800 200,702
37 P37 383.450 61.700 364,846 137 P137 382.150 61.800 212,14
38 P38 383.500 61.700 383,134 138 P138 382200 61.800 214,570
39 P30 383.550 61.700 399,503 139 P139 382.250 61.800 217,018
40 P40 383,600 61.700 413,308 140 P140 382.300 61.800 219,456
a1 P41 383.650 81.700 427,025 141 P141 382350 61.800 222 809
a2 P42 383.700 61.700 436,169 142 P14z 382 400 61.800 230,734
a3 P43 383750 61.700 443 789 143 P143 382450 61.800 238,658
44 P44 383.800 61.700 449,580 144 P144 382.500 61.800 246,583
15 P45 383.850 61.700 456,895 145 P145 382.550 61.800 252,374
B P46 363.900 61.700 466,039 148 P148 382 600 61.800 251,765
7 P47 383.850 81.700 478,84 147 P1a7 382.650 61.800 250,850
8 P48 384.000 61.700 491,947 148 P148 382.700 61.800 249,936
] P49 384.050 51.700 506,273 149 p149 382.750 61.800 243230
0 P50 384.100 61.700 521,818 150 P150 382 800 .800 227,980
il P51 384.150 1.700 537,058 | 151 P151 382,850 227 -
2 P52 384.200 §1.700 555,650 152 P152 382.900 1.800 232,258
3 P53 384.250 61.700 574,853 153 P153 382.950 1.800 243,840
7] P54 384.300 61.700 589,178 154 P154 383.000 800 255,727
5 P55 384.350 61.700 601,980 155 P155 383.050 1.800 269,748
B P56 _384.400_ 61700 | 611,124 156 P156 383.100 51,800 283464 |
5T P57 384.450 61,700 620,268 157 P157 383.150 51,800 205,656
8 P58 384 500 61.700 633,374 158 P158 383.200 800 307,238
9 P59 384.550 1.700 652,272 159 P159 383250 800 318,821
0 P80 384.600 1.700 662,635 160 P160 383.300 800 330,098
i P81 384,650 61.700 669,036 161 P161 383.350 1.800 339,852
2 Paz 384.700 81.700 670,865 182 P162 383.400 51.800 350,825
B P63 384.750 61.700 672,389 183 P163 383.450 51.800 380,578
7] PB4 381,650 61.750 215,494 164 P164 383.500 1.800 371,856
35 PBE 381.700 81.750 215,189 165 P165 383.550 1.800 351,739
6 et 381.750 1.750 214,884 168 P166 383.600 61.800 392,887
57 P67 381.800 61.750 214,579 167 P167 383.650 61.800 402,031
38 P68 381.850 61.750 214,274 168 P168 383.700 61.800 211,175
59 P89 381.800 61.750 213,970 169 P169 383.750 61.800 420,319
70 P70 381.950 61.750 213,665 170 P170 383.800 51,800 430,073
71 P71 382.000 1.750 213,360 171 P171 383.850 800 443,179
2 P12 382 050 61.750 215,788 172 P72 383.900 61.800 455876
73 PT3 382.100 61.750 218 173 P173 383.850 800 488,478
73 P4 382.150 81.750 220,875 174 P174 384.000 .800 280,974
75 P75 382.200 61.750 223,114 75 PATE 384,050 800 491,947
6 P78 362.250 61.750 225,552 178 P176 384.100 800 505,358
77 PIT 382.300 61.750 227,990 177 P77 384150 61.800 18,770
78 P78 382.350 61.750 231,038 178 P178 384.200 1.800 530,047
79 P79 382 400 61.750 238,963 179 P179 384.250 1.800 543,154
80 P8O0 382.450 61.750 246,888 180 P180 384.300 1.800 551,383
81 P81 382.500 61.750 254,813 181 P181 384,350 1.800 550,918
82 P82 382.550 61.750 262,738 182 P182 384.400 1.800 566,928
3 P83 382 600 81.750 265,786 183 P183 384.450 81.800 584,608
34 PB4 382,650 81.750 264,871 184 PiB4 384.500 61.800 506,798
35 P85 382.700 61.750 264,871 185 P185 384.550 1.800 615,695
) 3 382 750 81.750 250,241 188 P188 384800 800 625,450
7 P87 382 800 61.750 235,001 187 P187 384.650 800 630,022
38 P88 382.850 61.750 231,343 188 P188 384.700 1.800 630,938
) P89 382.900 61.750 228,600 183 P189 384.750 61.800 632,765
0 =] 382.950 61.750 240,487 190 P190 381.650 1.850 204,521
Po1 383,000 61.750 252,374 &1 P181 381.700 1.850 204,216 _
2 Po2 383,050 81.750 264 92 P182 381.750 850 203,911
3 Po3 383.100 51.750 276,149 93 P193 381,800 850 203,606
o4 (2] 883.150 31.750 288,341 194 P184 381.850 61.850 203,302
£ P95 383200 1750 300,228 195 P195 381.900 61.850 202,692
) P96 383.250 750 312,115 198 F198 381.950 61.850 202,387
a7 PoT 383.300 81.750 324,002 197 P197 382.000 ©1.850 202,082
38 P98 383.350 1.750 335,890 198 P18 382.050 1.850 201,778
) P9 383.400 1.750 347,777 199 P199 382.100 1.850 201,473
100 P100 383.450 1.750 359,054 200 P200 382 150 850 203,011
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4ol Pa0t 382.750 62.000 11,226
402 Pa02 382.800 62.000 10,312
403 P43 382.850 62.000 12,750
404 P404 382.900 62000 19,761
405 P40 362.550 62.000 229514
406 P406 383000 62.000 243535
407 P47 383.050 62.000 258,166
408 Pa08 383.100 62000 273,101
409 P409 383.150 62.000 284,074
410 P410 383.200 62.000 257,485
4 P11 383.260 62.000 304,800
413 P412 383.300 62.000 309,677
2 P413 383350 62.000 316,382
414 PA14 383.400 62.000 320,954
41 P415 383450 62.000 327,660
416 P16 383.500 62000 334,356
a7 Pa17 383.550 62.000 345548

418 PA18 383.600 62.000 361,168

a1 Pa19 383,650 62.000 377,342

3% Pa20 383.700 62.000 384,353
421 paz1 383.7650 62.000 390,754

) Paz2 383.600 62000 398,374

a2 Pa23 383.850 62.000 409,348

T a2 P424 383.900 62000 419,710
425 P425 383.950 62000 430,073
426 P426 384.000 62.000 440,13
427 P427 354.050 62000 443,36
428 P428 384.100 62.000 455371
429 P429 384.160 62000 462,686
430 P430 384,200 62.000 465,125
431 P43t 384250 62.000 462,686
432 Pa32 384.300 62.000 468,173
433 P433 384.350 62000 477,012
434 P434 384.400 62.000 496,214
436 P435 384,450 62.000 616,33
438 P438 384.500 62.000 537667 |

___aw Pa37 _384.550 62.000 553212

438 P38 384.600 62000 885,041
439 P439 384.650 62.000 554,736

384.700 62.000 —558688_ |
241 Paal 384.750 62000 665,404
442 Pa42 381,650 62050 179,521
243 PA43 381.700 62050 75,565
444 Paaq 381.750 62.080 73,431
245 Paas 381.800 62.050 72,822
248 P44 381.850 62,050 75,570
447 Paa7 381.900 62050 75
448 Pa4s 381.950 62.050 75870
329 PasS 382000 62060 75,565
450 Pas0 382060 62050 175,870

—_451 PAB1 £52080. 172212
452 P452 382.150 62050 173,126
253 P453 382200 62050 74,041
454 P454 382.260 62.050 74,041
455 P455 382300 62050 5870
456 P56 382.360 62.050 178,003
457 Pa57 382.400 62.050 182,270
458 P456 382.450 62.050 184,404
459 P459 362,500 62.050 186,538
460 2) 382560 62060 150,508
451 P461 352.600 62,050 199,034
262 P62 382,650 62.050 208483 |
263 P463 382.700 62050 217,627
454 P464 382.750 62050 221550 |
485 P4E5 382.600 62050 221,590
266 PAG6 382.850 62050 220066 |
A67 P467 362.900 62050 _ 222199 ]

) P48 382.950 62.060 28906 |
469 P469 383.000 62.050 235268 |
470 P470 383.050 62.050 252679 |
471 pa7 383100 62060 267,614
(7] PATZ 3831650 62050 277,063
a3 PaT: 383200 62050 289,255
474 P44 383260 62050 300,633
475 Pa75 333300 62050 305410 |
476 P4T6 333350 62050 12115
art Pazy 383.400 62.050 16,992
478 Pa78 383.450 62.050 19,735
79 Pa79 383.500 62.050 18738
480 P480 383,850 62.080 134,670
481 P48t 383.600 62050 7,771
[ P4a2 383650 62.050 363,097
483 pas3 383.700 62.050 363418
484 P434 383.760 62.050 376,123

P48S5 383800 _ 62050 383,134
486 Pags 353,850 62050 362,887
487 P487 383.900 62.050 402946 |
488 P88 383,550 62.050 413,309
489 P489 384.000 62.050 423672 |

—A4%0 P490 384.050 62050 433121
491 P49t 384.100 62.050 44165 |
492 P42 384150 62.050 448,970
453 P493 384.200 62.050 451,104
494 P484 384 250 62050 446837
495 PAS5 354,300 62050 4662856 |
496 Pagse 384.350 62050 467,563
457 PAST 384.400 62050 486,461
498 Pass 384.450 62050 505663
499 Pags 384.600 62050 526,085
500 P500 384.650 62.050 638,277

501 P501 384.600 62,050

502 P502 384.650 62,050

503 P503 384.700 62.050

504 P504 384.750 62050

505 P505 381.650 62160

508 WEN-AD 381.700 62100

507 381.750 62.100

508 WBN-CO 381.800 62.100

609 WEN-DO 381.850 62.100

10 WBN-E01 331.900 62.100

11 WEN-FO 381.950 62.100

12_ WEN-GO 382.000 62.100

13 WEBN-HO 382,050 62.100

14 WEN-101 382.100 62.100

15 WEN-JO 382.150 62100

15 WBN-KD 382.200 62.100

17 WEN-LO1 382250 62.100

18 WBN-MD 382.300 62100

19 WBN-NO{ 382.350 62100

520 VWBN-001 382.400 62.100

521 WEN-PO1 382.450 62100

522 WEN-QO 382.500 62.100

523 WEBN-RO 382550 62.100

[ 5% WEN-S0 382600 62.100

525 WBN-TO 382,650 62.100

526 WEBN-UD 382.700 62.100

527 WBN-VO 382.750 62.100

528 WBN-WD 382800 62.100

WEN-XO 382660 62.100

530 WEBN-YD 382600 62.100

531 WBN-Z0 "382.050 62.100

632 WEBN-ABO 383.000 62100

533 WBN-ACO 383,050 62.100

634 WEBN-ADO 383.100 62100

538 WBN-AEQ 383.180 62100

638 WBN-AF01 383.200 62.100

537 WBN-AGO 383.250 62100

538 WBN-AHO 383.300 62.100

539 WEN-AID1 333.350 62100

WBN-AJD 383400 62.100

41 WBN-AKD 383.450 62.100

42 WBN-ALD 383.500 62.100

43 WEBN-AMO 383.550 62100

44 WBN-AND 383.600 62.100

45 WBN-AOCO 383.650 62.100

48 WBN-APO 333.700 62.100

47 P505 383.750 62.100

48 P50S 383.800 62.100

49 PEO7 383.850 £2.100

550 PS03 333.900 62.100

551 P50S 383950 62100

£52 P510 384.000 62.100

553 P511 384.050 62.100

[ 654 P512 384.100 62100

685 P513 384.150 62.100

556 P514 384.200 62.100

557 P515 384.250 62.100

568 P16 384.300 62100

559 PSIT ~384.350 62.100

560 P518 384,400 62900

561 P59 384.450 62.100

562 PS520 334.500 62.100

563 P21 384.550 62.100

664 PR 384.600 62.100

565 PS23 _384.650 62.100

566 P524 384.700 62100

867 P625 384.760 62.100

[ 560 P526__ 381.650 62160

569 WBN-AD2 381.700 62.150

670 WBN-B02 381.750 62.160

579 WBN-COZ 381,800 62150

5712 WBN-D02 381.850 ~62.150

573 WBN-E02 381.900 62.150

574 WEN-F02 381.950 62.160

675 WEN-G02_ 382.000 62.150

576 WBN-H02 382.050 62.150

577 WEN-i02 382,100 62.150

578 WBN-J02 382.150 62150
Y WENKSZ

580 WBN-1.02 382250 62,150

581 WEN-M02 382.300 62.150

582 WEN-NG2 382.350 62.160

583 WEBN-002 382.400 62.150

584 WBN-PO2 382450 62.150

585 WBN-Q02 382,500 62.150

686 WBN-R02 382.550 62,150

687 WEN-502 382,600 62.150

588 WEN-T02 382,650 62.150

589 WBN-U02 382.700 62.150

590 WBN-VD2 382750 62.150

501 WEN-WO2_ 382,800 62.150

852 WBN-X02 382,850 62.150

| &3 WEN-Y02 382,900 62150

) WEBN-Z02 382950 62150

595 WBN-ABO2 383.000 62.150

[ 596 WBN-AC02 383.060 62.150

697 WBN-ADO2 383.100 62150

688 WBN-AED2 383,150 62.150

[ so9 WBN-AF02 383.200 62.150

600 WBN-AGO2 383.250 62.150
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WEN-ATS 381,700 62,850 624,000 501 P802
WEN-B16 381.760 62.850 189,995 1602 P803
WEN-G16 381.800 62850 197,461 1603 P804
WBN-D16 381.850 62850 207,831 1604 P85
WEN-E16 381.900 62850 222610 1505 P80G
WBN-F16 381.850 62.850 230,774 1506 P807
WEN-G16 382,000 62,850 240,309 1507 P88
WEBN-H18 362050 62.850 245,567 1568 P09
WBN-16 382.100 62.850 257,373 1509 P810
WENJ16 382150 62.850 281,669 1510 P311
WEN-K16 382200 62.850 305,432 15 PBT2
WEN-L16 382250 62.850 330,812 1512 P813
WEN-M16 362.300 62.850 345,566 15 P314
WEN-N16 382.350 62.850 355,457 15 PB15
WEBN-016 382.400 62.850 361,083 1516 P316
WBN-P16 362450 62850 364,628 1516 P87
WEBN-Q16 362,500 62,850 367,826 1517 WEN-ATB
WBN-R16 382.550 62.850 370,654 1518 WEN-B18
WBN-S16 382,600 62.850 71,329 1519 WBN-C18
WEN-T18 382.650 62,650 71,724 1520 WEN-D13
WEN-U16 382700 62850 71,853 1521 WBN-E18
WEN-VI6 362760 62850 371,209 1522 WEN-F18
WEN-W16 362.800 62.850 370,049 1623 WBN-G18
WBN-X16 382850 62850 356069 | 152 WEN-H1E
WBN-Y16 362.900 62.850 353,144 1525 WBN-118
WEN-Z16 382.950 62.850 331,307 1526 WEBN-118
WBN-AB16 353.000 82550 307454 1527 WBN-K13
WEBN-ACTE 363,050 62.850 277,517 1528 WEN-L18
WBN-AD16 383.900 62.850 267,614 1529 WBN-M18
WBN-AE16 383.150 62850 285512 1530 WEN-N18
WBN-AF16 383200 62850 306,347 1531 WEN-018
WBN-AGI6 383250 62.850 321,672 1532 WEN-P18
WEBN-AH16 363.300 62,850 336,048 1633 WBN-G18
WEN-AI16 383 360 62.850 353,199 1534 WEN-R18
WEN-AJ16 383.400 62,850 380,179 1536 WBN-518
WBN-AK 383.450 62,850 413 403 1536 WEN-T18
WEN-ALI 363500 62.850 429,835 1637 WEN-U18
WBN-AM 303.550 62550 433,586 1538 WBN-V13
WEBN-AN1 383.600 62850 438,093 1539 WEN-W18
WEN-AOTE — 333660 652860 240520 | 1640 WEN-XI8
WBN-AP1G 363.700 62,850 483239 1541 WEN-Y18
i) 383.750 62,850 434035 1542 WEN-Z18
785 333,800 62.850 441,048 1543 WBN-AB18
pT86 363860 _ 62,850 247,761 1584 WEN-AC18
p787 383,600 62,850 454,467 1545 WEN-AD18
20 383950 62.850 461,467 1548 WBN-AE18
p789 384.000 62.850 480,060 1547 WBN-AF18
F780 384.050 62.850 491,338 1648 WEN-AGIS
B791 384,100 82,850 485545 1549 WBN-AH1S
P792 364150 62850 479,755 1550 WEN-AI
P94 384.250 62850 470611 1552 WEN-AKIS
v785 384.300 62.850 466,384 1563 WEN-AL18
P96 384.350 62850 462382 | 1554 WEN-AMIB
F787 384.400 62.850 458,114 1565 WEN-ANTS
P88 384.450 62.650 454,162 1556 WEN-AQ18
F199 384.500 62.850 445,008 1857 WEN-AP18
PE00 361.650 62.900 182,880 1668 Pa1s
WEN-ATT 381.700 62900 624,000 1569 Pa19
WEBN-517 381.750 62900 191,637 1560 P80
WBN-C 381.800_ 62.900 196,614 1561 P821
WBN-D 381.850 62.600 207,722 1562 P62
WBN-E 361.900 62,900 227,805 1563 Pe23
WEBNF 381.950 62900 245,467 1564 Pe24
WEN-G17 382000 62900 249907 1665 P25
WEN-H1T 382,050 62,900 256,728 1566 Paz6
WENI17 382.100 62.900 267,443 1667 Pa27
7 382150 62500 278,602 1668 Fa28
WBN-KI7 382200 62,500 285,601 1569 P829
WEBN-LA7 362250 62.900 310,062 1570 PB30
WBN-M17 382,300 62900 325673 3571 PE31
WEN-N17 362 350 62900 335,417 1572 PE32
WBN-O17 362.400 62000 353691 1573 P833
WEN-P17 362450 62900 362,335 1574 PE34
WEBN-Q17 382500 62.900 363,54 1575 WEN-ATD
WEN-R17 362550 | 62900 3NS5 1576 WEN-B19
WEBN-S17 362.600 62900 373,064 1577 WEBN-C1g
WEBN-T17 362650 62900 373,842 1578 WEN-D19
352,700 62 500 EYC KL I [~ 1570 WER-ETS_
WENVIT 382.750 62.900 373,905 1560 WBN-F19
WBN-W17 382.800 62.900 372,725 1581 WENG1S
WEN-X17 382850 62900 370,308 1582 WEN-H19
WBN-Y7 382900 62900 357,981 1583 WBN-I19
WBN-Z17 382950 ~62600 335,676 1584 WEN-J19
WEN-ABT] 363.000 62900 307,716 1585 WEN-K19
WBN-AC 363.050 62900 276014 1586 WEN-L1S
WBN-AD 333100 62900 271,683 1587 WBN-Mi9
WEN-AET 363.150 62,00 290,843 1588 WEN-N19
WBN-AF17 363.200 62.900 315214 1569 WBN-019
WEN-AGT? 383250 62.900 235,517 1550 WEN-P19
WBN-AH1T 363.300 62,900 349,427 1591 WEN-Q10
WBN-AIT7 363.350 62.900 365,568 1592 WEN-R19
WEN-AJIT 363400 £2.900 387,903 1593 WEN-S19
WEBN-AKIT 383.450 62900 418,445 1594 WEN-T19
WENALIT 383500 62900 443,510 1585 WEN-U1S
WEN-AMIT 383.550 62,900 449976 1596 WBN-VIO
WEN-AN: 383.600 62900 454,632 1597 WBN-W19
WBN-AD17 363650 62900 453,747 1568 WEN-X19
62,900 484,521 1690 WBN-Y19
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2201 P1010 384,000 472,
2202 P1011 384.050 500 464 515
2203 P1012 384.100 63.500 455371
2204 | Pio13 384.150 63.500 446,837
2205 P1G14 384.200 63.500 439,826
2206 P1015 384250 63.500 433,426
2207 P1016 384.300 63.600 426,244
2208 P1017 384.350 63.500 423672
2209 P1018 384.400 63.500 418,186
2210 P1019 384.450 63.500 411,785
22 P1020 384,500 63.500 400,812
2212 P1021 381.650 63.550 230,429
24 WEN-A30 381.700 63.550 228,600
2214 WBN-B30 381.750 63550 226,773
22 WBN-C30 381.800 63.550 228971
22 WBN-D30 351,850 63.550 426
2 WEN-E30 —381.900 63.550 242,596
2218 WEN-F30 391.950 63.550 234,237
2219 WBN-G30 332,000 63650 233815
2220 WBN-H30 382 050 63.650 239245 |
2221 WBN-130 382.100 63550 255 147
222 WEN-J30 382180 63.550 276,791
F77%) WBN-K30 382.200 63.550 293,489
224 —WENL30 382250 63550 316539 |
2275 WBN-M30 382.300 63.550 340,942
2226 WBN-N30 362.350 63.550 353,715
227 WEN-030 382400 63.550 355,789
2228 WEN-P30 382.450 63.550 363,827
2229 WBN-Q30 382,600 63.650 368,965
2230 WEN'R30 382,550 63550 374,077
2231 WBN-S30 362,600 63550 379,163
232 WBN-T30 382.650 63.550 383,961
2233 WEN-U30 382.700 63.650 387,914
2234 WEN-V30 382.750 63550 391,484
2235 WEN-W30 362.800 63.650 398,847
2236 WEN-X30 382.850 63.550 399,487
2237 WBN-Y30 382.600 63.550 397,814
2238 WENZ30 382.950 53.550 397,412
2239 WBN-AB30 383000 63.550 395753
—249. — WBNACI0___ | 383050 | 63660 | 304160 |
241 WEN-AD30 383.100 63.650 404,14
242 WEN-AE3D 383150 63650 214,45
243 WEN-AF30 383200 63.550 407,714
2244 WBN-AG30 383.260 63.650 380,621
2245 WEBN-AH30 383.300 63.550 349215
2248 WER-AIZ0 383.350 63.550 337,488
2247 WEBN-AJ30 383.400 63.550 342814
2248 WEN-AK30 353.450 63.650 362,993
2249 WBN-AL3D 383.600 83.650 369,75
2250 WEN-AM3D 383.550 63.550 36024
2961 WEN-ANSD 383600 R F60 391321 |
22652 WBN-AO30 383650 63.550 408,842
2253 WBN-AP30 383.700 63.550 431,476
254 P1022 383.750 63.550 435559
2255 1023 383.800 63550 449,580
2256 P1024 353850 63550 459,029
2257 P1025 383.900 63.550 482,891
2258 P1026 383.960 63.560 464,210
2265 P1027 384.000 63.550 457,505
2260 PI028 384050 63580 249,275
2261 P1029 384.100 63.550 440,131
2262 P1030 384,160 63.650 432511
2263 P1031 384.200 63.550 426,110
2264 P1032 384.250 63.550 419,710
2265 P1033 384.300 63.650 413,309
2265 P1034 384.350 63550 408,737
2267 P1035 384.400 63.560 402,641
%8 F1038 384.450 63560 396,545 |
2269 P1037 384.500 63.560 388,620
2270 P1038 381.650 63.600 2331712___|
2279 WEN-A3 381.700 63600 233477
272 WBN-B31 381.750 63600 247,188
73 WEN-C3 331,800 63.600 245754
2274 WBN-D3 381.850 63.600 254,691
2275 WEN-E3 351.800 63.600 256,743
2276 WBN-F3: 381.950 63.600 250,266
277 WEN-G3 382.000 63600 242077
2278 WEN-H3 382,050 63,600 243535
=279 382,100 63,600 MMMMW!
2280 WEN-J31 382.150 63.600 285 360
2281 WEN-K3 382200 63.600 306,338
2 WEN-L3] 382 260 63600 32326
2283 WEN-M3 382300 63.600 340,016
2284 WENN3 382.350 63.600 345,668
2285 WBN-G3 382.400 63.600 359,329
2286 WBN-P31 382.450 63,600 365,245
2287 WBN-Q3 382.500 53.600 3N,158 |
2288 WEBN-R3 382,850 63.600 375811
2289 WEN-S3 382,600 63.600 380,409
2250 WBN-T3 382660 63.600 385,404
— 2291 WEN-U3 332,700 63.600 390,477
292 WBN-V3 382.750 63.600 394,782
263 WEN-W31 382,800 63.600 ~388,431
2294 WBN-X3 352850 63.600 404995
2268 WEN.Y3 382,800 63.600 412,063
% WEN-Z3 382.950 63600 416,585
2297 WEN-AB31 383.000 63600 a17,712
2283 WBN-AC3 333.050 63.600 416273
2299 WEN-AD3 383100 63,600 422417
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